## Table of Contents

### Chapter 1

**New to Remote Support?**
- Understanding session types .............................................................. 2
- Choosing a console option for conducting support sessions .............. 3
  - Using the CSR Dashboard ............................................................... 3
  - Using the icon tray ...................................................................... 4
  - Using the multi-session window .................................................... 4
- Communicating with your customer ................................................... 5
- Sharing application or desktop views and control with your customer .. 6
- Transferring files between computers ................................................. 7
- Printing from your customer's remote computer ............................... 8
- Recording Sessions ......................................................................... 9
- Viewing remote computer information ............................................ 10
- Running custom scripts on the remote computer .............................. 11
- Managing sessions ......................................................................... 12
- Assisting customers in multiple sessions ......................................... 13
- About the CSR dashboard tabs ....................................................... 13
  - About the Tools tab ..................................................................... 14
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Speaking in a voice call</td>
<td>39</td>
</tr>
<tr>
<td>Leaving and rejoining a voice call</td>
<td>39</td>
</tr>
<tr>
<td>Setting Voice Call options</td>
<td>40</td>
</tr>
<tr>
<td><strong>Managing a Customer’s Computer</strong></td>
<td>41</td>
</tr>
<tr>
<td>Viewing a customer's system information</td>
<td>42</td>
</tr>
<tr>
<td>Creating and modifying custom scripts</td>
<td>43</td>
</tr>
<tr>
<td>Running a custom script during a session</td>
<td>46</td>
</tr>
<tr>
<td>Saving and printing information about a customer's computer</td>
<td>47</td>
</tr>
<tr>
<td>Logging on to a customer's computer as a different user</td>
<td>48</td>
</tr>
<tr>
<td>Restarting a customer's computer</td>
<td>49</td>
</tr>
<tr>
<td><strong>Transferring Files</strong></td>
<td>51</td>
</tr>
<tr>
<td>Using basic file transfer</td>
<td>52</td>
</tr>
<tr>
<td>Using advanced file transfer</td>
<td>53</td>
</tr>
<tr>
<td><strong>Sharing Desktops and Applications</strong></td>
<td>57</td>
</tr>
<tr>
<td>Sharing desktops</td>
<td>58</td>
</tr>
<tr>
<td>Viewing a customer's desktop</td>
<td>58</td>
</tr>
<tr>
<td>Controlling a customer's desktop</td>
<td>59</td>
</tr>
<tr>
<td>Helping a customer to stop sharing</td>
<td>60</td>
</tr>
<tr>
<td>Showing your desktop to a customer</td>
<td>61</td>
</tr>
<tr>
<td>Giving control of your desktop to a customer</td>
<td>62</td>
</tr>
<tr>
<td>Stopping desktop sharing</td>
<td>63</td>
</tr>
</tbody>
</table>
Logging in to and out of the WebEx service site ................................................... 106

Using your list of meetings .................................................................................... 106

About your list of meetings ............................................................................. 107

Opening your meetings list .......................................................................... 107

Maintaining your scheduled meetings list ....................................................... 108

About the My WebEx Meetings page .............................................................. 108

About the My WebEx Meetings page - Daily tab ........................................... 109

About the My WebEx Meetings page - Weekly tab ....................................... 110

About the My WebEx Meetings page - Monthly tab ...................................... 112

About the My WebEx Meetings page - All Meetings tab ............................... 113

Maintaining Your Personal Meeting Room Page ............................................. 115

About your Personal Meeting Room page .................................................... 115

Viewing your Personal Meeting Room page .................................................. 116

Setting options for your Personal Meeting Room page ............................... 116

Sharing files on your Personal Meeting Room page ..................................... 117

Using Access Anywhere (My Computers) ....................................................... 118

About the My Computers page ..................................................................... 119

Maintaining files in your personal folders ..................................................... 120

About maintaining files in your folders ........................................................ 120

Opening your personal folders, documents, and files .................................. 121

Adding new folders to your personal folders ............................................... 122
Uploading files to your personal folders .......................................................... 123
Moving or copying files or folders in your personal folders ......................... 124
Editing information about files or folders in your personal folders ............... 124
Searching for files or folders in your personal folders ................................... 125
Downloading files in your personal folders ..................................................... 126
Deleting files or folders in your personal folders ............................................. 126
About the My WebEx Files > My Documents page ......................................... 127
About the Edit Folder Properties page ............................................................ 129
Opening the My Recordings Page ................................................................. 130
Uploading a recording file ............................................................................ 131
Editing information about a recording ........................................................... 131
About the Add/Edit Recording page .............................................................. 132
Playback control options .............................................................................. 133
About the Recording Information page ......................................................... 134
About the My WebEx Files > My Recordings page ........................................ 136
About the My WebEx Files > My Recordings > Meetings page ..................... 137
About the My WebEx Files > My Recordings > Sales Meetings .................... 137
About the My WebEx Files > My Recordings > Miscellaneous page ............ 137
Maintaining contact information .................................................................... 137
About maintaining contact information .......................................................... 138
Opening your address book .......................................................................... 138
Adding a contact to your address book ........................................................... 139
About the New/Edit Contact page ................................................................. 141
Importing contact information in a file to your address book ....................... 142
About the Contact Information CSV template ................................................. 143
Importing contact information from Outlook to your address book ............... 145
Viewing and editing contact information in your address book ..................... 146
Finding a contact in your personal address book ........................................... 147
Creating a distribution list in your address book .......................................... 147
Editing a distribution list in your address book ............................................. 149
About the Add/Edit Distribution List page ..................................................... 150
Deleting contact information in your address book ...................................... 151
Maintaining your user profile ......................................................................... 152
About maintaining your user profile ............................................................. 152
About the My WebEx Profile page ................................................................. 153
Editing your user profile .............................................................................. 158
Generating Reports .......................................................................................... 158
About generating reports ............................................................................... 159
Maintaining your Cisco Unified MeetingPlace Audio Conferencing accounts 161
Generating reports ....................................................................................... 164
Generating session data: The Query Tool ..................................................... 165
New to Remote Support?

Remote Support provides an interactive environment for conducting real-time customer support sessions over the Web. You can easily view, remotely control, and annotate a customer's applications or entire desktop to analyze and resolve customer issues.

---

<table>
<thead>
<tr>
<th>What you can do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Explore problems and demonstrate solutions in real-time support sessions with your customers:</td>
</tr>
<tr>
<td>- Assist multiple customers simultaneously [More…](on page 13)</td>
</tr>
<tr>
<td>- Add voice call, text messaging, and video to enhance communication with a customer [More…](on page 5)</td>
</tr>
<tr>
<td>- View or control a customer's application or entire desktop or allow a customer to do the same on your computer [More…](on page 6)</td>
</tr>
<tr>
<td>- Transfer files between your local computer and your customer's remote computer [More…](on page 7)</td>
</tr>
<tr>
<td>- Record all or part of a support session for training or archival purposes [More…](on page 9)</td>
</tr>
<tr>
<td>- Print documents from a customer's computer to a local printer [More…](on page 8)</td>
</tr>
<tr>
<td>- End a session, or escalate a session to another customer support representative by transferring session control or by transferring and relinquishing the session entirely [More…](on page 12)</td>
</tr>
<tr>
<td>- View, save, and print detailed information about a customer's computer, including information about the operating system, hardware, and Web browser [More…](on page 10)</td>
</tr>
</tbody>
</table>
Chapter 1: New to Remote Support?

For your customers, Support Manager presents a simple user interface, eliminating the need for customer training.

Understanding session types

A Remote Support session can be one of two types. A session type is determined by how the session begins.

- **Inbound session**: Customers click a Web page link to get help and are automatically placed in your support queue. After you are done assisting your current customer, you can accept the next customer in the queue. The session begins automatically with the customer in attendance. To use this feature, you must have WebACD installed.

- **Outbound session**: You start the session, and invite the customer by phone, email, or instant message. You provide the customer with the support session number and the Web site address for the support session. The customer then joins the session.

**Tip**: Depending on your site settings, you can choose to help customers in single session or multi-session mode:

- Single session—help one customer at a time
- Multi-session—help multiple customers simultaneously

More… (on page 13)
Chapter 1: New to Remote Support?

Choosing a console option for conducting support sessions

Depending on your site options, you can conduct support sessions using

- the CSR dashboard, which has a fixed set of tabs More… (on page 3)
- the compact icon tray, which saves space on your desktop More… (on page 4)
- the multi-session window, which is optimized for simultaneous sessions More… (on page 4)

Using the CSR Dashboard

The CSR Dashboard appears within your browser window and has a fixed set of tabs. To provide support to a customer, use the buttons on the tabs.

What you can do

- View session information
- View customer information
- Switch between dashboard tabs to invite, share, transfer files, and get additional support for your customer

Note: You cannot use some Remote Support features until a customer joins the support session.

If you are currently using the compact icon tray, and wish to switch to the CSR dashboard or the multi-session window, see your site administrator.
Chapter 1: New to Remote Support?

Using the icon tray

The compact icon tray is browser based, takes up little desktop space, and can easily be moved around your desktop.

What you can do:
1. View session info
2. View customer info
3. Click between icons to invite, share, transfer files, and get additional support for your customer

Note: You cannot use some Remote Support features until a customer joins the support session.

If you are currently using the compact icon tray, and wish to switch to the CSR dashboard or the multi-session window, see your site administrator.

Using the multi-session window

The multi-session window provides all the tools you need to assist multiple customers concurrently.

What you can do:
1. Click between customer tabs to assist customers
2. Click between task tabs to perform tasks on your customer's computer
3. Click between icons to perform common tasks, such as inviting, recording, and video streaming

Note: You cannot use some Remote Support features until a customer joins the support session.

If you are currently using the compact icon tray, and wish to switch to the CSR dashboard or the multi-session window, see your site administrator.
Communicating with your customer

- **Invite**—Send an email invitation to a customer or another support representative
- **Chat**—Start a chat with a customer or another support representative
- **Video**—Send live video using a video camera connected to your computer
- **Voice Call**—Start a voice call with a customer or another support representative

What it is

Invite a customer, and try enhancing your support sessions with video, voice call, and text messaging.

What you need for video and voice call

- a PC with at least 1.8 GHz CPU
- a small video camera plugged into your computer
- A supported sound card, and speakers and a microphone

Your customer needs a camera and a PC with at least 1.8 GHz CPU to join the video portion of the call. However, a customer need not install video equipment on his or her computer to view live video.

What you can do

- **Video**. To save bandwidth, while enhancing that personal touch, you can freeze video so your image remains on the screen. Those participating in the video session see a snapshot of your face, but you are not taking up valuable computer resources.
- **Chat**. Exchange instant messages with your customer.
Voice Call. Talk to your customer using voice over IP (VoIP)—an Internet–based telephony service that is cheaper than using traditional phone service.

Sharing application or desktop views and control with your customer

- Request View—Request to view a customer's application, desktop, or browser
- Request Control—Request to control a customer's application, desktop, or browser
- Share View—Let a customer view your application or desktop
- Share Control—Give control of your application or desktop to a customer

What it is
So often, showing something is much easier than explaining it. Using Support Center, you can start a support session and collaborate on either computer.

What you need
- a fast internet connection
- an ongoing support session
- permission to
  - view or control an application, browser, or the entire desktop on the customer's computer
  - have your customer view or control your application or desktop

What you can do
- View or take control of your customer's browser automatically when accepting a session
Chapter 1: New to Remote Support?

- View or take control of your customer's application or desktop.
- Pass control of your mouse to your customer to control your application or desktop.

You do not need to have your customer's applications installed on your computer or your applications installed on the customer's computer.

Transferring files between computers

Copy files to and from your customer's computer.

What it is

Transfer a file to a customer or get a file from your customer's computer in real time with just a couple of clicks. You can send and receive files freely in file sizes up to the bandwidth your Internet connection supports.

What you need

- your customer's permission to send or receive
- Optional. One or more folders prepared to house the files you receive
Chapter 1: New to Remote Support?

What you can do

During a session, you can transfer files from your computer to or from a customer's computer. Once a customer grants permission to you, you can transfer a single file, multiple files simultaneously, or an entire folder.

Printing from your customer's remote computer

What it is

During a support session, while you are controlling a customer's application or desktop, you can print a document that resides on the customer's computer to your local computer's default printer at your current location.

What you need

- this feature enabled for your site - if this feature is not appearing, contact your site administrator for assistance
- an ongoing session with your customer in which you are controlling your customer's application or desktop

What you can do

- Print a document currently displayed on the desktop.
- Use the remote computer's file manager to find, open, and print a document.
Recording Sessions

Record the current session for later playback.

What it is
Support Center includes WebEx Recorder, which provides a video recording of all screen activity in a session, including mouse movements and annotations.

What you need
- permission from the customer
- the appropriate sound card and the necessary audio input device connected to your computer

What you can do
- You can record all the actions that you take during a support session, including any annotations that you make when sharing your customer's desktop or application. You can also optionally capture audio in a recording.
- You can record on your local computer or to the server.

A customer cannot record a support session using WebEx Recorder.
Chapter 1: New to Remote Support?

Viewing remote computer information

What it is
During a support session, with the customer's permission, you can view detailed information about your customer's computer. This information can help you to diagnose and repair the computer.

What you need
- this feature enabled for your site - if this feature is not appearing, contact your site administrator for assistance
- an ongoing session with your customer

What you can do
- View system information on the remote computer, make changes to the customer's computer, then restart the computer to view the results in system information.
- Run a script to diagnose and repair a system issue. More… (on page 11)
- Either print the displayed information or save it to a file.
Running custom scripts on the remote computer

What it is

In a Remote Support session, you can access the Custom Scripts Library to upload and execute one or more frequently-used scripts on your customer's computer to quickly evaluate and resolve product issues. For example, if your customer has installed one of your routers, and data routing is slow, you can upload a custom script that evaluates this type of router issue and then fixes it.

What you need

- this feature enabled for your Support Center site - if this feature is not appearing, contact your site administrator for assistance
- an ongoing session with your customer
- permission from your customer

What you can do

- create custom scripts and publish them to the Scripts Library
- modify or delete custom scripts that you created
• run one or more custom scripts on your customer's computer
• view script output in the session details report

Managing sessions

• Transfer Control—Transfer control of your support session to another support representative who will become the primary representative.
• Transfer Session—Transfer your support session to a WebACD queue or agent and leave the session.
• End Session—End the support session.

What it is
During a support session, you can further assist your customer by getting additional help from another support representative, or escalating and relinquishing the session to another support representative.

What you need
an ongoing session with your customer

What you can do
• Transfer temporary control of a session to another support representative.
• Transfer the session to another support representative and leave the session.
• End the session.
Assisting customers in multiple sessions

What it is
Take advantage of your ability to multitask. Conduct concurrent sessions to help multiple customers in one single, easy-to-use window.

What you need
Multiple sessions must be enabled for your site.

What you can do
- Conduct concurrent sessions with customers, both inbound and outbound, up to the number of sessions allowed for your site.
- Use session features in each individual session. For example, you can perform a file transfer for one customer, chat with another, and review the system information for yet another customer.

About the CSR dashboard tabs
The CSR dashboard is a browser-based console that displays four tabs:
Chapter 1: New to Remote Support?

- **Tools tab**—Use these tools to communicate with your customer. *More…* (on page 14)
- **Desktop tab**—Use these tools to view, share, and control computer desktops. *More…* (on page 15)
- **Application tab**—Use these tools to view, share, and control computer applications. *More…* (on page 15)
- **Session tab**—Use these tools to end or transfer a session. *More…* (on page 16)

### About the Tools tab

<table>
<thead>
<tr>
<th>Use this option….</th>
<th>To….</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Invite</strong></td>
<td>Invite a customer to join a session by phone, email, or instant message; or invite another support representative to join a session by email.</td>
</tr>
<tr>
<td><strong>Chat</strong></td>
<td>Open the Chat panel to send an instant chat message to a customer or another support representative.</td>
</tr>
<tr>
<td><strong>Video</strong></td>
<td>Open the Video panel to send live video to all participants in your support session. You must have a supported video camera connected to your computer.</td>
</tr>
<tr>
<td><strong>Transfer File</strong></td>
<td>Choose an option for transferring files to or from a customer’s computer.</td>
</tr>
<tr>
<td></td>
<td>- <strong>File Transfer-Basic</strong>: Lets you publish one or more files in a window, from which a customer can download the files to his or her computer.</td>
</tr>
<tr>
<td></td>
<td>- <strong>File Transfer-Advanced</strong>: Lets you browse the directory structure on the customer’s computer and transfer files to or from that computer</td>
</tr>
<tr>
<td><strong>Audio</strong></td>
<td>Use voice over IP (VoIP)—an Internet–based telephony service to speak with a customer or another representative participating in a support session.</td>
</tr>
<tr>
<td><strong>Notes</strong></td>
<td>While you are supporting a customer, take notes about the session. The notes are saved and become part of the Session Details report.</td>
</tr>
</tbody>
</table>
Chapter 1: New to Remote Support?

About the Desktop tab

<table>
<thead>
<tr>
<th>Use this option...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Request View</td>
<td>Send a request to a customer to view his or her entire desktop. Once customer approves your request, a sharing window opens, in which you can view the customer's desktop and any actions that the customer takes on the desktop.</td>
</tr>
<tr>
<td>Request Control</td>
<td>Send a request to a customer to control his or her entire desktop. Once customer approves your request, a sharing window opens, in which you can remotely control the customer's desktop.</td>
</tr>
<tr>
<td>Share View</td>
<td>Send a request to a customer to open a view of your desktop on his or her computer. Once the customer approves your request, a sharing window opens on the customer’s computer, displaying your desktop. The customer can view any actions that you take on your desktop.</td>
</tr>
<tr>
<td>Share Control</td>
<td>Send a request to a customer to open a view of your desktop on his or her computer and let the customer control your desktop. Once the customer approves your request, a sharing window opens on the customer's computer, displaying your desktop. The customer has full control of your on your desktop.</td>
</tr>
</tbody>
</table>

About the Application tab

<table>
<thead>
<tr>
<th>Use this option...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Request View</td>
<td>Send a request to a customer to view an application on his or her computer. Once customer approves your request, the customer can select an application to share. A sharing window then opens on your computer, in which you can view the customer's application and any actions that the customer takes in the application.</td>
</tr>
<tr>
<td>Request Control</td>
<td>Send a request to a customer to control an application on his or her computer. Once customer approves your request, the customer can select an application to share. A sharing window then opens on your computer, in which you can remotely control the customer's application.</td>
</tr>
<tr>
<td>Share View</td>
<td>Send a request to a customer to open a view of your application on his or her computer. Once the customer approves your request, you can select an application to share. A sharing window then opens on the customer's computer, displaying your application. The customer can...</td>
</tr>
</tbody>
</table>
Chapter 1: New to Remote Support?

<table>
<thead>
<tr>
<th>Use this option...</th>
<th>To....</th>
</tr>
</thead>
<tbody>
<tr>
<td>Share Control</td>
<td>Send a request to a customer to open a view of your application on his or her computer and let the customer control your application. Once the customer approves your request, you can select an application to share. A sharing window then opens on the customer’s computer, displaying your application. The customer has full control of your application.</td>
</tr>
<tr>
<td>Co-browsing View</td>
<td>Automatically start viewing the window from which the customer invoked the session, such as a browser or MS Outlook window. If, during the session, you end co-browsing and need to co-browse again, you can initiate co-browsing as required.</td>
</tr>
<tr>
<td>Note: Co-browsing requires WebACD. See your site administrator for additional information.</td>
<td></td>
</tr>
<tr>
<td>Co-browsing Control</td>
<td>Automatically start controlling the window from which the customer invoked the session, such as a browser or MS Outlook window. If, during the session, you end co-browsing and need to co-browse again, you can initiate co-browsing as required.</td>
</tr>
<tr>
<td>Note: Co-browsing requires WebACD. See your site administrator for additional information.</td>
<td></td>
</tr>
</tbody>
</table>

About the Session tab

<table>
<thead>
<tr>
<th>Use this option....</th>
<th>To....</th>
</tr>
</thead>
<tbody>
<tr>
<td>Session Options</td>
<td>Choose a display mode for shared software. The mode you choose affects the imaging quality and performance of desktop and application sharing.</td>
</tr>
<tr>
<td>▪ Standard: Provides better imaging quality, but slower performance.</td>
<td></td>
</tr>
<tr>
<td>▪ Screen Sampling: Provides better performance, but lower imaging quality.</td>
<td></td>
</tr>
<tr>
<td>Record Session</td>
<td>Record your support session using WebEx Recorder.</td>
</tr>
<tr>
<td>Note: This option is not available if your site administrator has turned on the Auto Record option for your account. In this case, your support sessions are recorded automatically.</td>
<td></td>
</tr>
<tr>
<td>Transfer Control</td>
<td>Transfer control of your support session to another support representative who will become the primary support representative.</td>
</tr>
<tr>
<td>Use this option....</td>
<td>To....</td>
</tr>
<tr>
<td>--------------------</td>
<td>-------</td>
</tr>
<tr>
<td>Transfer Session</td>
<td>Transfer your support session to a WebACD agent or queue and leave the session. <strong>Note</strong> This option is available <em>only</em> if you are a WebACD agent.</td>
</tr>
<tr>
<td>End Session</td>
<td>End the support session. If you have transferred control to another support representative, this option allows you to leave the session instead of ending it.</td>
</tr>
</tbody>
</table>

## Setting up Support Manager manually

To conduct a support session with a customer, both you and your customer must have Remote Support installed on your computers.

Unless your system or network policies restrict it, Support Center automatically installs Remote Support on your computer the first time you either start or join a support session. Installation takes only a few moments, so you normally do not experience a delay in starting or joining a session.

**To set up Remote Support manually:**

1. Go to your Support Center Web site.
2. On the navigation bar, expand **Support**.
3. Under **Downloads**, click **Download Support Manager for Windows**.
Managing a Support Session

The following table describes the tasks associated with managing a support session. For detailed instructions on a particular task, click "More" by the task description.

- start a session More… (on page 19)
- invite a customer More… (on page 22)
- invite another support representative More… (on page 24)
- support more than one customer More… (on page 26)
- assist a support session More… (on page 27)
- transfer session control to another support representative More… (on page 29)
- transfer a session to a WebACD agent or queue More… (on page 30)
- record a session More… (on page 21)

Starting a support session

A Remote Support session provides an environment in which you can interact with your customer to resolve product issues.

A Remote Support session can be one of two types. A session type is determined by how the session begins.

- **Inbound session**: Customers click a Web page link to get help and are automatically placed in your support queue. After you are done assisting your current customer, you can accept the next customer in the queue. The session begins automatically with the customer in attendance. To use this feature, you must have WebACD installed.
Chapter 2: Managing a Support Session

- **Outbound session**: You start the session, and invite the customer by phone, email, or instant message. You provide the customer with the support session number and the Web site address for the support session. The customer then joins the session.

**Tip:** Depending on your site settings, you can choose to help customers in single session or multi-session mode:
- Single session—help one customer at a time
- Multi-session—help multiple customers simultaneously *More…* (on page 13)

To start a support session:

1. Log in to your Support Center Web site.
2. Click the **Start a Support Session** button on the Web site.

Depending on your user and site settings, Support Manager begins a session in single or multi-session mode.
- Mult-session—the multi-session window opens and you can start inviting or accepting customers
- Single-session—depending on your site settings, the CSR dashboard or icon tray appears on your screen.

For more information about session types, see your site administrator.

**Important:** If you are using the CSR dashboard, you must keep the Remote Support page open throughout the support session. If you close it, or open another Web page in the browser window in which it appears, the session will end.

3. Invite a customer to your support session *More…* (on page 22)

Once the customer joins the session, the Remote Support page appears in the customer’s Web browser.
4 Optional. Invite another customer support representative to your session. For details, see *Inviting another support representative to a support session* (on page 24).

Tip: A customer can also join a support session by accessing your Support Center Web site, then clicking Join on the navigation bar.

---

## Recording a support session

Use WebEx Recorder to create a video recording of all screen activity on your computer, including mouse movements and annotations. You can also capture synchronized audio in your recording.

WebEx Recorder is available in these versions:

- **Local meeting recorder.** This recorder captures screen activity and audio in a support session, and then saves the recorded data in a recording file on your computer. See *WebEx Recorder and Player User's Guide* for information on this recorder.

- **Network based meeting recorder.** This recorder captures screen activity and audio on a WebEx recording server, thereby saving processor resources and hard disk space on your computer. See *WebEx Player for Advanced Recording Format (.arf) Files User's Guide* for information on this recorder.

To start recording your support session:

1 Do one of the following:

   - On the CSR dashboard, click the **Session** tab, then click the **Record** button.
   - On the icon tray, or in the multi-session window, click the **Record** icon.

If a default recorder was specified by your site administrator, the recorder panel appears and recording starts automatically.

If no default recorder was specified by your site administrator, the WebEx Recorder Setup dialog appears:
2 Choose the applicable recorder.
3 Click **Start Recording**.

The recorder panel appears and recording starts automatically.

### Taking session notes

During a support session, while you are supporting a customer, you can take notes about the session.

**To take notes during a session:**

1 On the icon tray, or in the multi-session window, click the **Session** button.
2 On the session menu, choose **Session Notes**.

   The Session Notes panel opens.
3 Type notes into the panel window and click **Save**.

As you end the session, you will be prompted to review and edit the session notes. When the session ends, the notes are saved and become part of the Session Details report.

### Inviting a customer to a support session

You can invite one or more customers to a support session by
Chapter 2: Managing a Support Session

- sending an invitation email message
- instructing the customer to join from the Web site
- sending an instant message with a join link

If you invite another customer to join the session, the original customer receives a message that the other customer has joined the session.

You can provide support to any customer who has joined the session, by selecting the customer in the Customer Information panel. More… (on page 26)

To invite a customer to a support session by email:
1. Do one of the following:
   - On the CSR dashboard, click the Tools tab, then click Invite.
   - On the icon tray, , or in the multi-session window, click the Invite icon.
   
   The Invite dialog box, or panel, appears.

   You can invite
   - more than one customer to a single support session.
   - more than one customer, each to an individual concurrent session

2. Select Customer.
   For details on asking another CSR to assist in your session, see Inviting another support representative to a support session (on page 24).
3. Type the email address of the recipient in the text box.
4 **Optional.** By default, the **Send using my own email program** check box is selected. When selected, this option:

- Enables the invitation to be sent by your own email program, rather than being sent by Support Manager directly.
- Helps to prevent your invitation from being removed by the recipient’s spam filter.
- Helps the recipient to receive the invitation more quickly.

5 Click **OK**.

If you chose to send the invitation using your own email program, the invitation appears in a new message window. Send the invitation.

The customer receives an email invitation with the support session link.

**Tip:** Alternatively, you can invite the customer to join your support session by doing one of the following:

- Go to the URL for the support session, click **Join**, and type in the session number. The URL and the session number appear in the middle of the Invite dialog box or panel.
- Copy the join link for the support session into an instant message. The join link appears at the bottom of the Invite dialog box or panel.

---

**Inviting another support representative to a support session**

You can invite another customer support representative to a support session by

- sending an invitation email message
- copying the join link into an instant message **More…** (on page 27)
- instructing the support representative to join from the Web site. **More…** (on page 27)

To invite a customer support representative to a support session by email:

1 Do one of the following:
   - On the CSR dashboard, click the **Tools** tab, then click **Invite**.
   - On the icon tray, or in the multi-session window, click the **Invite** icon.
Chapter 2: Managing a Support Session

2 The Invite dialog box, or panel, appears.

2 Select **Support representative**.

![Invite dialog box](image)

**Optional.** Click **Invite WebACDAgent** to invite a WebACD Agent to the support session. This option is available only if you are a WebACD agent.

If the agent accepts the invitation, the session is relinquished to the agent or queue for resolution and your participation is ended. *More…* (on page 30)

3 Type the email address of the support representative in the text box.

4 **Optional.** By default, the **Send using my own email program** check box is selected. When selected, this option

- Enables the invitation to be sent by your own email program, rather than being sent by Support Center directly.
- Helps to prevent your invitation from being removed by the recipient's spam filter.
- Helps the recipient to receive the invitation more quickly.

If you chose to send the invitation using your own email program, the invitation appears in a new message window. Send the invitation.

The support representative receives an email invitation with the support session link.
Attending to multiple customers in a single support session

If two or more customers join a single support session, you can attend to each customer individually.

To choose a customer, select the customer in the Customer Information panel.

Note:
- If you or a customer shares a desktop or application, all participants in the support session can view the shared software.
- Once you switch to a different customer, all current sharing activities end automatically. For example, if you are sharing your application or desktop, or viewing a customer's application or desktop, the sharing window automatically closes.

Attending to multiple customers simultaneously

If your site supports it, and your privileges allow it, you can manage multiple remote sessions concurrently in a single, easy-to-use Support Manager window.

For example, you can run a script on one customer's computer, answer questions in a chat window for another customer, and review system information on yet a third customer's computer.
The maximum number of customers you can assist simultaneously, is set by your system administrator.

Tip: You can invite more than one customer to any one session when you are using the multi-session client, just as you would if you were using the single session client. More… (on page 26)

When you first start a session and invite a customer (on page 22), or if you accept your first customer from an inbound queue, the multi-session window opens automatically. The name of the customer being assisted appears on the session tab.

In the multi-session window, you can perform most of the tasks that you perform in a single session for all sessions.

Assisting another support representative

If you have a user account on a Support Center Web site, you can assist another customer support representative in an in-progress support session to:
Chapter 2: Managing a Support Session

- Observe application and desktop sharing
- Participate in a chat
- View video that the support representative is sending
- Take control of the support session if the support representative passes control to you
- Become the primary support representative if the current primary support representative transfers the session to you.

You can join a support session as an assistant from:

- An invitation email message, if the support representative sent you an invitation
- A link in an instant message
- Your Support Center Web site

To join a support session as an assistant from an invitation email or instant message:
1. Click the link in the email message or instant message to join the session.
   If you are not already logged in to your Support Center Web Site, the Log In page appears.
2. Log in to your Support Center Web site.
   The Assist Support Session in Progress page appears.
3. Click Join.

To join a support session as an assistant from your Support Center Web site:
1. Ensure that the support representative who is currently controlling the support session provides you with the session number for the session.
2. Go to your Support Center Web site.
3. Log in to your Support Center Web site.
4. On the navigation bar, expand Provide Support, and then click Assist Session.
   The Assist Support Session In Progress page appears.
5. Type the Support Session number in the text box, and then click Join.
   You are now an assistant in the support session.
Chapter 2: Managing a Support Session

Note: As an assisting support representative, you do not have control of the support session. However, the primary support representative can pass control to you or relinquish the session to you entirely. For details, see Transferring session control to another support representative (on page 29), and Transferring a session to a WebACD agent or queue (on page 30).

Transferring session control to another support representative

You can transfer control of a support session to another support representative who is assisting you in your session. This option is useful, for example, if you need to escalate a call.

Once you transfer a session, you can remain in the session to observe application and desktop sharing, participate in a chat, and view video. At any time, the support representative to whom you transferred the session can transfer the session back to you.

Note: The support representative to whom you want to transfer control of the support session must first join your session by doing one of the following:

- Click the link to join the support session in your invitation email or instant message. More… (on page 24)
- Click the Assist Session link on the navigation bar on your Support Center Web site, and then provide the support session number.

To transfer control of a support session:

1. Do one of the following:

   - On the CSR dashboard, click the Session tab, then click the down arrow on the Transfer Session button and choose Transfer Control. The Transfer Control dialog box appears with a list of all customer support representatives who have joined the session as assistants.

   - On the icon tray, or in the multi-session window, click the Session button, and then hold the cursor over Transfer Control to choose from a list of all customer support representatives who have joined the session as assistants.

2. Select the support representative's name in the list.
Chapter 2: Managing a Support Session

The support representative now controls the support session. The control session functions now become unavailable to you unless the support representative transfers control of the session back to you.

**Note:** After you transfer session control to an assistant customer representative, the following occurs:
- You can leave the session, but you cannot end the session unless control is transferred back to you.
- All support activities automatically end, including application and desktop sharing, file transfer, chat, video, and recording.
- If you started a voice call, the voice call continues if the system to which you are transferring control supports voice call requirements.

3 **Optional.** You can transfer and relinquish the session to a WebACD agent or queue. This option is available *only* if you are a WebACD agent. *(More… (on page 30))*

**Transferring a session to a WebACD agent or queue**

You can transfer a support session to a WebACD agent or queue of WebACD agents. This option is useful, for example, if you need to escalate a call and leave the session so that you can assist another customer. When you transfer a session, you can include a message providing some useful information about the session.

**Note:** The option to transfer a session is available *only* if you are a WebACD agent.

**To transfer and leave a support session:**

1. Do *one* of the following:
   - On the CSR dashboard, click the **Session** tab, then click the down arrow on the **Transfer Session** button and choose **Transfer Session**.
   - On the icon tray, or in the multi-session window, click the **Session** button, then choose **Transfer Session**.

The Transfer Session dialog box appears.
Chapter 2: Managing a Support Session

Do one of the following:

- click the **Queues** tab and select a queue—you can select only one queue
- select one or more WebACD agents in the **Agents** tab

2. Optional. You can type a personal message to an agent or to all available agents in a queue. The message can be up to 345 characters long.

The session is now relinquished to the WebACD agent or queue for resolution and your participation is ended.

**Important:** If you transfer a session to a WebACD agent or queue, the following occurs:

- You automatically leave the session.
- If you started a voice call, the voice call ends.

### Obtaining permission from a customer automatically

Once you make a request to perform a support activity—such as to view or control a customer's application—your request appears in a message box on the customer's screen. The customer must grant permission to you by clicking **OK** in the message box. However, a customer can allow you to perform all activities without having to grant permission to you each time you make a request. This option can be useful, for example, if the customer wants to let you perform support activities while the customer is away from his or her computer.
For you to obtain permission to perform support activities automatically, the customer must click the **Grant permission for all actions during this session without prompting again** check box in the request message box that appears on his or her screen. The following figure shows the message box that appears on a customer's screen once you request to control an application:

If the customer selects this option, you can freely view or control applications, view or control the desktop, transfer files, or record a session.

### Ending a support session

You can end a support session at any time.

**To end a support session:**

Do *one* of the following:

- On the CSR dashboard, click the **Session** tab, then click **End Session**.
- On the floating icon tray, click the **Session** button, and choose **End Session**.
- In the multi-session window, select the tab for the session you want to end, then click the **Session** button, and choose **End Session**.

A message appears, asking you to confirm that you want to end the session.

**Note:**

- A customer can leave a support session at any time, by clicking **Leave Session** on the Remote Support page.
- A customer cannot end a support session.
Using Voice Call

Voice Call (powered by GIPS) is an option that allows support session participants to speak to each other if they have computers enabled for voice over IP (VoIP)—an Internet–based telephony service. Up to two participants can speak at a time in a voice call session. As, the support representative, you determine who can speak by passing the microphone to a participant.

The following table describes the voice call tasks associated with your role as support representative and your customer's role as a participant. For detailed instructions on a particular task, click "More" by a task description.

<table>
<thead>
<tr>
<th>Role</th>
<th>Task description:</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSR</td>
<td>Start and manage a voice call:</td>
</tr>
<tr>
<td></td>
<td>- set voice call options [More…](on page 40)</td>
</tr>
<tr>
<td></td>
<td>- start or end a voice call [More…](on page 34)</td>
</tr>
<tr>
<td></td>
<td>- speak in a voice call [More…](on page 38)</td>
</tr>
<tr>
<td></td>
<td>- Allow a participant to speak [More…](on page 37)</td>
</tr>
</tbody>
</table>

![Voice Call Interface](image)
### Chapter 3: Using Voice Call

#### Role

<table>
<thead>
<tr>
<th>Role</th>
<th>Task description:</th>
</tr>
</thead>
<tbody>
<tr>
<td>customer</td>
<td>Participate in a voice call:</td>
</tr>
<tr>
<td></td>
<td>- set voice call options [More…](on page 40)</td>
</tr>
<tr>
<td></td>
<td>- join a voice call [More…](on page 36)</td>
</tr>
<tr>
<td></td>
<td>- speak in a voice call [More…](on page 38)</td>
</tr>
<tr>
<td></td>
<td>- leave or rejoin a voice call [More…](on page 39)</td>
</tr>
</tbody>
</table>

#### Starting or ending a voice call

**Support representative**

Once you start a voice call during a support session, any participating customer, or support representative, whose system is enabled for voice over IP (VoIP)—an Internet–based telephony service—can join the voice call.

**Note:** Before starting a voice call,

- ensure that your computer has a sound card and either speakers and a microphone, or a headset with an integrated microphone. For better audio quality and greater convenience, use a computer headset with a high-quality microphone.
- if you have not done so already, use the Audio Setup Wizard to fine tune your computer's settings for Voice Call. [More…](on page 40)

To start a voice call during a support session:

1. Do one of the following:
   - On the CSR dashboard, click the **Tools** tab, then click **Voice Call**.
   - On the icon tray, or in the multi-session client, click the **Voice Call** icon.
2. Select **Start Voice Call**.

The following occurs:

- The Volume dialog box appears.
Chapter 3: Using Voice Call

- A **voice call** indicator appears near your name. For example:

  ![Voice call indicator]

- If you are using a headset, the following status bar appears at the bottom of the console:

  ![Voice call indicator]

- If you are using desktop or laptop speakers, the following indicator appears at the bottom of the console.

  ![Voice call indicator]

- The Join Voice Call message box automatically appears in the customer's session window. The customer can then choose to participate in the voice call session.

You can end a voice call in a support session at any time.

**To end a voice call:**

1. Do one of the following:
Chapter 3: Using Voice Call

- On the CSR dashboard, click the **Tools** tab, then click the down arrow on the **Voice Call** button.
- On the icon tray, or in the multi-session window, click the **Voice Call** icon.

2 Select **End Voice Call**.

**Note:** Although the voice call ends, the support session continues until you end it.

### Joining a voice call

**Customer or other support representative**

When you start a voice call, the Voice Call invitation automatically appears on your customer's session window (and on the session window of the participating support representative, if any.):

Advise your customer to click **Yes** to accept the invitation and join the conference.

When your customer joins a voice call conference, the following happens on the customer's screen:

- The Volume dialog box appears. Your customer can adjust the speaker or microphone volume.
Chapter 3: Using Voice Call

The Voice Call indicator appears beside your customer's name. For example:

Tip: Before joining a voice call session, advise your customer to use the Audio Setup Wizard to fine-tune the computer's settings for Voice Call. More… (on page 40)

Allowing a participant to speak in a voice call

Support representative

Once you start a voice call, up to two participants can speak at a time. You can specify which participants can speak by passing the microphone to a customer or to another support representative.
To allow a participant to speak in a voice call:

1. Do one of the following:
   - On the CSR dashboard, click the **Tools** tab, then click the down arrow on the **Voice Call** button.
   - On the icon tray, or in the multi-session window, click the **Voice Call** icon.

2. Select **Pass Mic To**.

   - The **Voice Call** indicator turns green next to that participant's name.

   Select the name of the participant whom you want to allow to speak.

   The participant can now speak until you pass the microphone to another participant.
Speaking in a voice call

Support representative and customer

As a support representative you have a choice of using speakers and a microphone or a headset with a microphone. The latter is recommended for better audio quality and convenience.

To participate in a voice call your customer must use a headset with a microphone. If the customer has a working headset, the following appears on the customer's console:

The customer simply speaks into the microphone.

Tip:
- Before a voice call, your customer can use the Audio Setup Wizard to select speaker setup.
- After you start a voice call, your customer can specify audio options by temporarily leaving the voice call to use the Audio Setup Wizard, and then rejoining the session.

For information the Audio Setup Wizard, see Setting Voice Call options (on page 40).

Leaving and rejoining a voice call

Customer or other support representative

During a support session, your customer, or an assistant support representative, can leave your voice call without leaving the session, and rejoin the voice call at any time.

To leave a voice call, advise your customer to:
1. Click the down arrow on the Voice Call button.
2. Select Leave Voice Call.

To rejoin a voice call, advise your customer to:
1. Click the down arrow on the Voice Call button.
2. Select Join Voice Call.
Setting Voice Call options

Support representatives and customers

- Use the Audio Setup Wizard to
  - specify audio equipment and set optimal volume levels.
  - ensure that the audio equipment is set to its optimal volume levels.
- Use the Volume dialog box to adjust the volume for the speakers or microphone at any time.

To use the Audio Setup Wizard for Voice Call:
1. Click the Voice Call button.
2. Choose Audio Setup Wizard.
   A wizard or dialog box appears.
3. Follow the directions to specify settings.

To set the speaker or microphone volume:
1. Click the Voice Call button.
2. Select Volume.
   The Volume dialog box appears.
3. Set the speaker or microphone volume as appropriate.
The following table describes the tasks that help you diagnose and resolve hardware or software issues on a customer’s computer. For detailed instructions on a particular task, click "More" by the task description.

**Note:** The technical support features described here can be disabled for a WebACD queue by your site administrator. If you do not see these features appearing on your site, contact your site administrator for assistance.

<table>
<thead>
<tr>
<th>task description</th>
<th>More… (on page)</th>
</tr>
</thead>
<tbody>
<tr>
<td>On a customer’s computer:</td>
<td></td>
</tr>
<tr>
<td>▪ view detailed system information</td>
<td>(on page 42)</td>
</tr>
<tr>
<td>▪ run custom scripts to evaluate and resolve customer issues</td>
<td>(on page 43)</td>
</tr>
<tr>
<td>▪ save or print information about the computer</td>
<td>(on page 47)</td>
</tr>
<tr>
<td>▪ log on as a different user</td>
<td>(on page 48)</td>
</tr>
<tr>
<td>▪ restart the computer</td>
<td>(on page 49)</td>
</tr>
</tbody>
</table>
Viewing a customer's system information

**Note:** Technical support features such as this one can be disabled for a WebACD queue by your site administrator. If this feature is not appearing on your site, contact your site administrator for assistance.

During a support session, with the customer's permission, you can view detailed information about your customer's computer. This information can help you to diagnose and repair the customer's computer. If you or your customer make any changes to the system, you can restart the customer's computer remotely, and then view the changes to the system information.

Once you display information about a customer's computer, you can either print it or save it to a file.

**To view system information:**

1. Do one of the following:
   - On the CSR dashboard, under **Customer Information**, click the **System Information** button.
   - On the icon tray, click the **Customer System Information** icon.
   - In the multi-session window, click the **System Information** tab for the customer.

   The customer is asked for permission to view the system information.

2. After the customer grants permission, the System Information window appears.
Chapter 4: Managing a Customer’s Computer

Creating and modifying custom scripts

**Note:** Technical support features such as this one can be disabled for a WebACD queue by your site administrator. If this feature is not appearing on your site, contact your site administrator for assistance.

A custom scripts is a script that you, or another CSR, can creates to run on a customer's computer. Such a script, once created is often useful in other support sessions.

You can create such frequently-used scripts, and then store them in the Custom Scripts Library for selection and upload, as required, during a support session.

**To view the list of available scripts in your Custom Scripts Library**

1. Log in to your Support Center Web site.
2. On the left navigation bar click **Scripts Library**.

The Customer Scripts Library dialog appears:

**Optional.** In the list on the left, click a category to view a panel that contains the corresponding information.

**Optional.** To view the latest system information, click **Refresh**.

**Tip:**
- You can save or print information about a customer's computer. *More…* (on page 47)
- You can restart the customer's computer at any time, and then view updated system information. *More…* (on page 49)
You can create, modify, publish or delete customer scripts from the Custom Scripts Library.

Tip: Click on any column heading to sort the scripts.

To create a custom script

1. Click Add New Script.
   
   The Add New Script dialog box appears.
2 Enter a unique name in the **Script Name** field.

3 Choose a category from the **Category** drop-down list. (Categories are created by your site administrator.)

4 **Optional.** Enter a description of the script for clarification purposes.

5 If it is not selected already, select **Publish to Script Library** if you want to have this script available to yourself and other CSRs during support sessions.

6 Click **Browse** to navigate to the script execution file.

7 If another script is required as input to the execution script, click **Browse** to select it.

8 Click **Submit**.

If the script contains errors, for example, if the script name already exists, you can correct the errors. Once the script is successfully submitted, the new script is created and displayed in the Script Library.

**To modify or delete a custom script**

1 Log in to your Support Center Web site.

2 On the left navigation bar click **Scripts Library**.

   The Customer Scripts Library dialog appears:

   Click **Edit** or **Delete** under the **Actions** column.

   - **Edit**—modify the script definition, including changing the script execution file or the input file required by the execution file, if any.

   - **Delete**—confirm the delete request to delete the script from the library. You can delete only those scripts that you created.
Running a custom script during a session

While you are in a session with a customer, you can upload and execute one or more custom scripts on your customer's computer to quickly evaluate and resolve problems.

To run a custom script during a support session.

1. On the CSR console menu, choose **Customer computer > Custom Scripts Library**.

   The Custom Scripts Library dialog box appears with a list of available scripts for your site.

   - Scripts can be up to 1 MB in size.
   - Multiple scripts run sequentially in the order you specify here.
   - In a multi-session window, script execution can proceed concurrently across multiple sessions

   **Tip:** Click on any column heading to sort the script library.

2. Use the **Move Up** or **Move Down** keys to order scripts.

3. Click **Run Scripts**.

   The customer is asked to grant permission. After permission is received, the scripts are executed on the customer's computer.
The log output of the script is displayed in the Chat window along with any errors that may have been encountered. The log is also available in the Session Details report.

**Note:** Scripts are run in temporary folders. Nothing remains on the customer’s computer once the script execution is complete.

---

**Saving and printing information about a customer's computer**

**Note:** Technical support features such as this one can be disabled for a WebACD queue by your site administrator. If this feature is not appearing on your site, contact your site administrator for assistance.

If you view information about a customer's computer, you can either save the information to a text file (.txt) or print it on a printer connected to your computer.

**To save or print information about a customer's computer:**

1. Display information about the customer's computer. For instructions, see *Viewing a customer's system information* (on page 42).

2. In the System Information window, do one of the following:
   - To save the information to a file, click the **Save** button.
   - To print the information, click the **Print** button.

**Note:** Support Manager displays categories of information about a customer's computer on separate panels. However, the saved file or printout includes the system information in all of the categories. You need not save or print each category of information individually.
Logging on to a customer's computer as a different user

**Note:** Technical support features such as this one can be disabled for a WebACD queue by your site administrator. If this feature is not appearing on your site, contact your site administrator for assistance.

During a support session, you can log on to a customer's computer as another user. For example, you may want to log on to the computer using an administrator account so you can perform additional activities on the computer. If the customer's computer is attached to an internal network, you must log on using an account on that network.

You can log off the customer's computer at any time during the session, and automatically log the customer back on the computer. If you are logged on to the customer's computer when you end the session, Support Manager automatically logs the customer back on to his or her computer.

**Note:** Logging on as a different user temporarily logs the customer off of the computer; however, it does not close any programs that are running on the customer's computer.

To log on to a customer's computer as a different user:

1. Do one of the following:
   - On the CSR dashboard, under **Customer Information**, click the **Log On as Different User** button.
   - On the icon tray, or in the multi-session window, click the **Session** button, then choose **Customer Computer > Log On As Different User**.

   A message appears, informing you that the customer has received your request to log on to his or her computer. Your request appears in a message box on the customer's screen. The customer must grant permission to you by clicking **OK** in the message box.

2. Click **OK** to close the message box on your computer.

   If the customer approved your request, the Log On to Customer Computer dialog box appears.

3. Provide the required account information, and then click **OK**.
To log off the customer's computer:

Do *one* of the following:

- On the CSR dashboard, under **Customer Information**, click the **Log off** button.
- On the icon tray, or in the multi-session window, click the **Session** button, then choose **Customer Computer > Log out [user name]**.

### Restarting a customer's computer

**Note:** Technical support features such as this one can be disabled for a WebACD queue by your site administrator. If this feature is not appearing on your site, contact your site administrator for assistance.

During a support session, you can restart a customer's computer remotely. Once the customer's computer restarts, the customer can rejoin the support session automatically, without having to provide the session number or other information.

1. Do *one* of the following:
   - On the CSR dashboard, under **Customer Information**, click the **Reboot Computer** button.
   - On the icon tray, or in the multi-session window, click the **Session** button, then choose **Customer Computer > Reboot**.

   A message appears, informing you that the customer has received your request to restart his or her computer. Your request appears in a message box on the customer's screen. The customer must grant permission to you by clicking **OK** in the message box.

2. Click **OK** to close the message box on your computer.

The customer's computer restarts. The customer must then log back in to his or her computer or network. A message then appears on the customer's screen, allowing the customer to rejoin the support session.
If your site permits it, during a support session, you can transfer files to or from a customer's computer. For example, you can deliver patches or updates to a customer's computer, or upload log files from the customer's computer to your computer for later analysis.

The following table describes two options for transferring files to and from a customer's computer depending on the configuration of your site and user account. For detailed instructions on a particular task, click "More" by the task description.

<table>
<thead>
<tr>
<th>task description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic: publish one or more files for a customer to download during a support session</td>
</tr>
</tbody>
</table>
Using basic file transfer

During a support session, you can publish files that reside on your computer in a window, which appears on the customer’s screen. A customer can then download the files to his or her computer.

To publish files during a support session:

1. Do one of the following:
   - On the CSR dashboard, click the Tools tab, and then click Transfer File.
     In the Choose File Transfer Option dialog box that appears, select Basic File Transfer.
   - On the icon tray, click the File Transfer icon, then choose File Transfer Basic.
   - In the multi-session window, click the File Transfer tab, then click Start File Transfer Basic.

A message appears, informing you that the customer has received your request to transfer files. Your request appears in a message box on the customer’s screen. The customer must grant permission to you by clicking OK in the message box.

2. Click OK to close the message box on your computer.
The File Transfer window appears on your screen and the customer’s screen.

3. Click **Share File**.

4. Select the file that you want to publish.

5. Click **Open**.

   The file appears in the File Transfer window.

   The customer selects the file, and then clicks **Download** to select a directory to receive the transfer.

   **Optional.** Publish additional files that you want the customer to download.

To stop publishing files during a support session:

In the title bar of the File Transfer window, click the **End File Transfer** button.

Support Manager closes the File Transfer window on the customer's screen.

### Using advanced file transfer

The advanced file transfer option provides two modes for transferring files:

- If your site permits it and you are in sharing mode, your customer grants permission and can view all actions that you take when transferring files. The customer can stop the file transfer at any time.

- In non-sharing mode, the customer grants permission, but cannot see your actions or stop the file transfer once it begins.

You can perform the following file transfer tasks:

- Transfer any file types to or from a customer's computer at any time, or when viewing or controlling a customer's desktop. You can transfer files of up to 150 MB at once.
Chapter 5: Transferring Files

- Access files on the customer's network, if the drives are mapped on the customer's computer and your Support Center service includes this option.
- Delete files on the customer's computer.
- Rename files on the customer's computer.

**Important:** You cannot transfer files if you or another support representative is viewing or controlling a customer's application. To transfer files to or from your computer, you must stop application sharing.

To transfer files to or from a customer's computer:

1. Do *one* of the following:
   - On the CSR dashboard, click the **Tools** tab, and then click **Transfer File**.
     In the Choose File Transfer Option dialog box that appears, select **Advanced File Transfer**.
   - On the icon tray, click the **File Transfer** icon, then choose **File Transfer Advanced**.
   - In the multi-session window, click the **File Transfer** tab, then click **Start File Transfer Advanced**.
     A message appears, informing you that the customer has received your request to transfer files. Your request appears in a message box on the customer's screen. The customer must grant permission to you by clicking **OK** in the message box.

2. Click **OK** to close the message box on your computer.

Once the customer grants permission to you, the WebEx File Transfer window appears. The file directory for your computer appears in the pane on the left. The file directory for the customer's computer appears in the pane on the right.
To create a new folder, click the **New Folder** button.

To select multiple files, hold down the **Ctrl** key when clicking the files.

You can cancel the file transfer if it is already in progress, by clicking the **Abort Transfer** button.

3. In the pane for either your computer or the customer's computer, browse to the folder *in which* you want to transfer, delete, or rename files.

4. In the other pane, select the files or folder that you want to transfer.

5. Do any of the following:
   - Click the appropriate arrow button to transfer the files or folder from one computer to the other.
   - Right-click to delete or rename a file.

If you are not also using desktop sharing, a message appears on the customer's screen, asking the customer to grant permission for you to transfer, delete, or rename the file. The customer must click **OK** in the message box for the action to proceed.

Once Support Manager transfers, deletes, or renames a file, the status bar on the WebEx File Transfer window displays a message to indicate that the action is complete.

**Note:** A customer can allow you to transfer, delete, or rename files during the support session, without having to grant permission to you each time you request to do so. 

*More… (on page 31)*
Sharing lets you view or control a customer's application, browser, or entire desktop, without the need to run any of the customer's applications on your computer. Similarly, a customer can view or control your application or desktop.

- Desktop sharing is ideal for viewing or controlling multiple applications at once, or accessing other areas of a customer's computer. More… (on page 59)

- Application sharing is useful if you want to demonstrate or troubleshoot a single application on a customer's computer, and generally provides better performance than desktop sharing. More… (on page 63)

- Co-browsing enables you to automatically share the browser window from which the customer originally invoked the session. In addition, you can choose to co-browse if the need arises in a session. More… (on page 70)

The following table describes the sharing tasks that you can perform. For detailed instructions on a particular task, click "More" by the task description.
Chapter 6: Sharing Desktops and Applications

**Task description:**

Share software:
- Share applications [More…](on page 63)
- Share your desktop [More…](on page 58)
- Co-browse a click-to-connect window [More…](on page 70)
- Printing documents from a customer’s computer [More…](on page 71)
- Control views of shared software [More…](on page 72)
- Annotate shared software [More…](on page 74)

### Sharing desktops

Desktop sharing is ideal for viewing or controlling multiple applications at once, or accessing other areas of a customer’s computer. You can simply view, or view and control, a customer’s desktop:

- view a customer’s desktop [More…](on page 58)
- control a customer’s desktop [More…](on page 59)
- instruct a customer on how to stop sharing a desktop [More…](on page 60)
- show your desktop to a customer [More…](on page 61)
- give desktop control to a customer [More…](on page 62)
- stop sharing your desktop with a customer [More…](on page 63)

### Viewing a customer's desktop

You can view a customer's desktop without controlling it.
To view a customer's desktop:

1. Do one of the following:
   - On the CSR dashboard, click the **Desktop** tab.
   - On the icon tray, click the **Remote Control** icon.
   - In the multi-session window, click the Customer tab, then click the **Sharing** tab.

2. Click **Request View**.
   
   A message appears, informing you that the customer has received your request. Your request appears in a message box on the customer's screen. The customer must grant permission to you by clicking **OK** in the message box.

3. Click **OK** to close the message box on your computer.

Once the customer grants permission to you, the customer's desktop appears in a sharing window on your screen. On the customer's screen, the Desktop View window appears, indicating that the customer is sharing his or her desktop.

**Note:**
- For tips that can help you to share more effectively, see *Tips for sharing desktops or applications* (on page 73).
- By default, the customer's desktop appears in a full-screen view on your computer. You can switch your display to a standard window at any time. *More…* (on page 72)
- A customer can allow you full viewing privileges during the support session, without having to grant permission to you each time you request to do so. *More…* (on page 31)
- When viewing a customer's desktop, you can transfer files to or from the customer's computer. For details, see *More…* (on page 51)

**Controlling a customer's desktop**

You can remotely control a customer's entire desktop.

To control a customer's desktop:

1. Do one of the following:
   - On the CSR dashboard, click the **Desktop** tab.
   - On the icon tray, click the **Remote Control** icon.
Chapter 6: Sharing Desktops and Applications

- In the multi-session window, click the Customer tab, then click the Sharing tab.

2 Click Request Control.

A message appears, informing you that the customer has received your request. Your request appears in a message box on the customer's screen. The customer must grant permission to you by clicking OK in the message box.

3 Click OK to close the message box on your computer.

Once the customer grants permission to you, the customer's desktop appears in a sharing window on your screen. On the customer's screen, the Desktop Control window appears, indicating that the customer is sharing his or her desktop.

4 To begin controlling the desktop, click your mouse button in the sharing window on your screen.

Note:
- For tips that can help you to share more effectively, see Tips for sharing desktops or applications (on page 73).
- By default, the customer's desktop appears in a full-screen view on your computer. You can switch your display to a standard window at any time. More… (on page 72)
- A customer can take back control of the desktop at any time by clicking his or her mouse on the desktop. You can also take control again by clicking your mouse in the window in which the shared desktop appears.
- A customer can allow you full viewing privileges during the support session, without having to grant permission to you each time you request to do so. More… (on page 31)

Helping a customer to stop sharing

If a customer is sharing his or her desktop or applications, you can instruct the customer on how to stop sharing.

To stop sharing:
1 Do one of the following:
   - On the icon tray, click the Session button.
   - In the title bar of any open window, click the Sharing button.
   - In the lower-right corner of your desktop, click the Sharing icon.
Chapter 6: Sharing Desktops and Applications

2 On the menu that appears, choose **Stop Sharing**.

**Showing your desktop to a customer**

You can allow a customer to view your desktop. Viewing the desktop does not allow the customer to control it remotely.

1 Do *one* of the following:
   - On the CSR dashboard, click the **Desktop** tab.
   - On the icon tray, click the **Remote Control** icon.
   - In the multi-session window, click the Customer tab, then click the **Sharing** tab.

2 Click **Share View**.

   A message appears, informing you that the customer has received your request. Your request appears in a message box on the customer's screen. The customer must grant permission to you by clicking **OK** in the message box.

3 Click **OK** to close the message box on your computer.

Your desktop appears in a sharing window on the customer's screen. On your computer, the Desktop View window appears, indicating that you are sharing your desktop.

*Note:* For tips that can help you to share more effectively, see *Tips for sharing desktops or applications* (on page 73).
Giving control of your desktop to a customer

During a support session, you can give control of your desktop to your customer. If you are already showing your desktop to a customer, you can let the customer control it without stopping the current desktop sharing session.

Caution: A customer who has remote control of your desktop can run any programs and access any files on your computer that you have not protected with a password.

To give control of your desktop to the customer:

1. Do one of the following:
   - On the CSR dashboard, click the Desktop tab.
   - On the icon tray, click the Remote Control icon.
   - In the multi-session window, click the Customer tab, then click the Sharing tab.

2. Click Request Control.

   A message appears, informing you that the customer has received your request. Your request appears in a message box on the customer’s screen. The customer must grant permission to you by clicking OK in the message box.

3. Click OK to close the message box on your computer.

   Your desktop appears in a sharing window on the customer’s screen. On your computer, the Desktop View window appears, indicating that you are sharing your desktop.

4. Instruct the customer to click his or her mouse in the sharing window.

5. To temporarily take back control of your desktop, click your mouse anywhere on your desktop.

Note: For tips that can help you to share more effectively, see Tips for sharing desktops or applications (on page 73).
Stopping desktop sharing

To stop sharing:

1. Do one of the following:
   - On the icon tray, click the Session button.
   - In the title bar of any open window, click the Sharing button.
   - In the lower-right corner of your desktop, click the Sharing icon.

2. On the menu that appears, choose Stop Sharing.

Sharing applications

Application sharing is useful if you want to demonstrate or troubleshoot a single application on a customer's computer, and generally provides better performance than desktop sharing.

You can simply view, or view and control, a customer's application:

- view a customer's application More… (on page 64)
- control a customer's application More… (on page 65)
- instruct a customer on how to share an application More… (on page 66)
- instruct a customer on how to stop sharing an application More… (on page 60)
- show your application to a customer More… (on page 67)
- show multiple applications to a customer More… (on page 68)
- give application control to a customer More… (on page 69)
- stop sharing your application with a customer More… (on page 70)
Viewing a customer's application

You can view an application that is running on the customer's computer. Viewing an application does not allow you to control it remotely.

1 Do one of the following:
   - On the CSR dashboard, click the Application tab.
   - On the icon tray, click the Remote Control icon.
   - In the multi-session window, click the Customer tab, then click the Sharing tab.

2 Click Request View.

   A message appears, informing you that the customer has received your request. Your request appears in a message box on the customer's screen. The customer must grant permission to you by clicking OK in the message box.

3 Click OK to close the message box on your computer.

   Once the customer grants permission to you, the Application View dialog box appears on the customer's computer.

   The customer can use the options in this dialog box to choose the application that you want to view.

4 Ask the customer to choose the application that you want to view.

   If necessary, provide the customer with instructions for choosing an application. More… (on page 66)

   Once the customer chooses the application that you want to view, it appears in a sharing window on your computer.

Note:
- For tips that can help you to share more effectively, see Tips for sharing desktops or applications (on page 73).
- By default, the customer's application appears in a full-screen view on your computer. You can switch your display to a standard window at any time. More… (on page 72)
- The customer can choose additional applications for you to view from Application View dialog box, so you can view multiple applications simultaneously.
- A customer can allow you full viewing privileges during the support session, without having to grant permission to you each time you request to do so.
Controlling a customer's application

Once a customer gives you permission to control an application, you can remotely control any application on a customer's computer.

To control a customer's application:

1. Do one of the following:
   - On the CSR dashboard, click the Application tab.
   - On the icon tray, click the Remote Control icon.
   - In the multi-session window, click the Customer tab, then click the Sharing tab.

2. Click Request Control.

   A message appears, informing you that the customer has received your request. Your request appears in a message box on the customer’s screen. The customer must grant permission to you by clicking OK in the message box.

3. Click OK to close the message box on your computer.

   Once the customer grants permission to you, the Application Control dialog box appears on the customer's computer. The customer can use the options in this dialog box to choose the application that you want to control.

4. Ask the customer to choose the application that you want to control.

   If necessary, provide the customer with instructions for choosing an application. More… (on page 66)

   Once the customer chooses the application that you want to control, it appears in a sharing window on your computer.

5. To begin controlling the application, click your mouse button in the sharing window.
Helping a customer to share an application

Once a customer accepts your request to view or control an application, the Application View or Application Control dialog box appears on the customer’s screen.

By default, the dialog box shows a list of all applications currently running on the customer's computer. You can instruct the customer to do one of the following:

- If the application you want to view or control is currently running, ask the customer to select it in the list, and then click Share.
- If the application you want to view or control is not currently running, ask the customer to click New Application. The New Application dialog box appears, showing a list of all applications on the computer. Ask the customer to select the application, and then click Share.

Helping a customer to stop sharing

If a customer is sharing his or her desktop or applications, you can instruct the customer on how to stop sharing.

To stop sharing:

1. Do one of the following:
Chapter 6: Sharing Desktops and Applications

- On the icon tray, click the **Session** button.
- In the title bar of any open window, click the **Sharing** button.
- In the lower-right corner of your desktop, click the **Sharing** icon.

2. On the menu that appears, choose **Stop Sharing**.

**Showing an application to a customer**

You can allow a customer to view your application. Viewing the application does not allow the customer to control it remotely.

1. Do **one** of the following:
   - On the CSR dashboard, click the **Application** tab.
   - On the icon tray, click the **Remote Control** icon.
   - In the multi-session window, click the Customer tab, then click the **Sharing** tab.

2. Click **Request Control**.
   A message appears, informing you that the customer has received your request. Your request appears in a message box on the customer’s screen. The customer must grant permission to you by clicking **OK** in the message box.

3. Click **OK** to close the message box on your computer.
   The Application View dialog box appears, showing a list of all applications currently running on your computer.

4. Do **one** of the following:
   - If the application you want to share is currently running, select it in the list, and then click **Share**.
   - If the application you want to share is not currently running, click **New Application**. The New Application dialog box appears, showing a list
of all applications on your computer. Select the application, and then click Share.

If the application is not already running, it starts automatically.

Your application appears in a sharing window on the customer's screen.

Note:
- You can share multiple applications simultaneously. More… (on page 68)
- For tips that can help you to share more effectively, see Tips for sharing desktops or applications (on page 73).

### Sharing multiple applications

If you are already sharing an application with a customer, you can share additional applications simultaneously. Each application that you share appears in the sharing window on the customer's screen.

**To share an additional application:**

1. Do any of the following:
   - On the icon tray, or in the multi-session window, click the Session button.
   - On the title bar of the application that you are currently sharing, click the Sharing menu.
   - In the lower-right corner of your desktop, click the Sharing button.

2. On the menu that appears, choose Select Application.
   The Application View dialog box appears, showing a list of all applications that are currently running on your computer.

3. Do one of the following:
   - If the application you want to share is currently running, select it in the list, and then click Share.
   - If the application you want to share is not currently running, click New Application. The New Application dialog box appears, showing a list of all applications on your computer. Select the application, and then click Share.

Your application appears in the sharing window the customer's screen.
Tip: Alternatively, you can share multiple applications by sharing your computer's desktop. More… (on page 61)

Giving control of your application to a customer

You can give control of an application to your customer. If you are already showing an application to a customer, you can let the customer control it remotely without stopping the current application sharing session.

Caution: A customer who has remote control of your application can open any files associated with that application on your computer that you have not protected with a password.

To give control of an application to the customer:

1. Do one of the following:
   - On the CSR dashboard, click the Application tab.
   - On the icon tray, click the Remote Control icon.
2. Click Share Control.

   A message appears, informing you that the customer has received your request. Your request appears in a message box on the customer's screen. The customer must grant permission to you by clicking OK in the message box.

   Click OK to close the message box on your computer.

   One of the following occurs:
   - If you are already showing an application to the customer, the customer can then click in the sharing window to gain control of the application. Skip to step 4.
   - If you are not already showing an application with the customer, the Application Control dialog box appears, showing a list of all applications that are currently running on your computer.
3. If the Application Control dialog box appears, do one of the following:
   - If the application you want to share is currently running, select it in the list, and then click Share.
### Chapter 6: Sharing Desktops and Applications

- If the application you want to share is not currently running, click **New Application**. The New Application dialog box appears, showing a list of all applications on your computer appears. Select the application, and then click **Share**.

4. To temporarily take back control of your application, click your mouse in the application.

---

### Stopping application sharing

**To stop sharing:**

1. Do *one* of the following:
   - On the icon tray, click the **Session** button.
   - In the title bar of any open window, click the **Sharing** button.
   - In the lower-right corner of your desktop, click the **Sharing** icon.

2. On the menu that appears, choose **Stop Sharing**.

---

### Co-browsing

Before you accept a session that is invoked from a click-to-connect link, Co-browsing enables you to join the session and automatically start sharing the window from which the customer invoked the session, such as a browser or MS Outlook window. You can view or control the customer's window.

If, during the session, you end co-browsing and need to co-browse again, you can initiate co-browsing as required.

**Note:**

- Co-browsing requires WebACD. See your site administrator for additional information.
- Before co-browsing actually begins, the customer is asked for, and must give,
To start co-browsing from within a click-to-connect session:

1. Do one of the following:
   - On the CSR dashboard, click the **Desktop** tab.
   - On the icon tray, click the **Remote Control** icon.
   - In the multi-session window, click the Customer tab, then click the **Sharing** tab.

2. Click **Request Co-Browsing > View** or **Control**.
   A message appears, informing you that the customer has received your request. Your request appears in a message box on the customer's screen. The customer must grant permission to you by clicking **OK** in the message box.

3. Click **OK** to close the message box on your computer.

The click-to-connect window from which your customer originally invoked the session is automatically selected as the share window.

If the original window information is unavailable, then your customer is shown the standard application selection dialog. The customer can select an application for sharing.

---

**Printing documents from a customer's computer**

When controlling a customer's application or desktop during a support session, you can open a document that resides on the customer's computer and print it to your local computer's default printer at your current location.

To print a customer's document:

1. On the customer's computer, open the document that you want to print.

2. In the customer's application, open the Print options.

3. Print the document using the **WebEx Document Loader**, which appears in the list of printers.

   The WebEx Document Loader prints the document to a file, then sends the file to your local computer's default printer.
Controlling views of a shared desktop or application

When viewing or controlling a customer's desktop or applications you can specify options for determining how the desktop or application appears on your screen:

- control your view of a customer's desktop or application, such as display it in a full screen [More…](on page 72)
- choose the number of colors in which to display a customer's shared desktop or application [More…](on page 73)

Controlling your view of a customer's desktop or application

When viewing or controlling a customer's desktop or application, you can specify the following options, which determine how a shared application or desktop appears on your screen:

- Display the shared desktop or application in a full-screen view or a standard window. A full-screen view of a shared application or desktop fits your entire screen and does not include a title bar or scroll bars.
- Scale, or resize, a shared desktop or application to fit the full-screen view or standard window in which it appears.

Your site administrator sets the default view for your user account.

A customer can also specify these options when viewing or controlling your desktop or application.

To control your view of a shared application or desktop:

1. Do either of the following:
   - On the icon tray, or in the multi-session window, click the Session button.
   - In the title bar of the sharing window, click the Sharing button.

2. On the menu that appears, choose View, then choose an option for viewing the shared desktop or application.
Note: If you are using the screen sampling option for displaying shared desktops and applications, you can also specify the number of colors with which to view the shared desktop or application. More… (on page 73)

Specifying the color mode for a shared desktop or application

When viewing or controlling a customer's desktop or application, you can choose one of the following color modes:

- **256 colors**—Specifies that a shared desktop or application appears in 256 colors in the viewer on your screen. This option requires less bandwidth for sharing desktops or applications than does the **High color** option, but provides lower imaging quality. Thus, this option is useful if a customer is using a dial-up connection to attend a support session.

- **High color (16-bit)**—Specifies that a shared desktop or application appears in 16-bit color in the viewer on your screen. This option requires more bandwidth than the **256 color** option, but provides better imaging quality.

Your site administrator sets the default color mode for your user account.

A customer can also specify a color mode when viewing or controlling your desktop or application.

To specify the color mode for a shared desktop or application:

1. Do either of the following:
   - On the icon tray, or in the multi-session window, click the **Session** button.
   - In the title bar of the sharing window, click the **Sharing** button.

2. On the menu that appears, choose **Color Mode**, then choose color option.

Tips for sharing desktops or applications

The following are tips that can help you to share software more effectively during a support session:
To improve the performance of desktop and application sharing, instruct the customer to close all applications that you do not need to view or control. Closing these applications conserves processor usage and memory on the customer's computer, thus helping to ensure that the customer's client software can send images quickly during a session. Also, to ensure that a maximum amount of bandwidth is available for sharing, ask the customer to close any applications that use bandwidth, such as instant messaging or chat programs, and programs that receive streaming audio or video from the Web.

If, during application sharing, you see a crosshatched pattern on your screen, the customer is covering a shared application with another window on his or her computer's desktop. Instruct the customer to move or close the other window.

You can improve performance of desktop or application sharing by reducing the number of colors in which the shared software appears. More… (on page 73)

It is recommended that both you and the customer use a dedicated, high-speed Internet connection when sharing an application or desktop. If you or a customer is using a dial-up Internet connection, you may notice a delay in viewing or interacting with a shared application. In this case, you can adjust the quality of the display to improve performance.

Annotating shared desktops and applications

When sharing your desktop or application, or viewing or controlling a customer's desktop or application, you can use annotation tools to draw and illustrate information on the shared screen. You can:

- allow everyone, including your customer, to annotate, or limit annotation to CSRs only.
- make annotations and use pointers More… (on page 75)
- remove, or clear, annotations and pointers More… (on page 77)
- change the color with which you are annotating shared software More… (on page 77)
- take a screen capture of the shared information, including annotations More… (on page 78)
- stop annotating More… (on page 78)

All support session participants can view annotations as they are made.
Annotating a shared desktop or application

You can annotate a desktop or application that either you or the customer is sharing. The customer and any other support representatives in the session can see all your annotations.

To annotate a shared desktop or application:

1. On the icon tray that appears during desktop or application sharing, click the Annotation icon.

   If the Annotation button does not appear on the icon tray, choose Annotation Panel on the Session menu.

   The Annotation panel appears.

   Annotation mode starts, and your mouse pointer becomes a highlighter tool with which you can begin making annotations.

2. Optional. On the Annotation panel, select another tool for making annotations.

   Note:
   - For details about annotation tools, see Using annotation tools on shared content.
   - If you want to annotate your desktop or application, and the customer is currently controlling it remotely, you must first regain control of the application or desktop before you can open the Annotation panel.
   - The Annotation panel automatically opens on the customer's computer when you open the panel on your screen. You and the customer can then annotate a shared desktop or application simultaneously.
   - A customer can also start annotating a shared desktop or application. In this case, the Annotation panel automatically opens on your screen.
   - Once you or a customer makes annotations, you can save an image of the shared software, including the annotations. 

Using annotation tools on shared content

In a support session, you can use annotation tools on shared content to annotate, highlight, explain, or point to information on your own screen or on your customer's screen. And, you can allow your customer to annotate as well:
<table>
<thead>
<tr>
<th>Annotation Tool</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pointer</td>
<td><img src="example.png" alt="Pointer Icon" /></td>
<td>Lets you point out text and graphics on shared content. The pointer displays an arrow with your name and annotation color. To display the laser pointer, which lets you point out text and graphics on shared content using a red “laser beam,” click the downward-pointing arrow. Clicking this button again turns off the pointer tool.</td>
</tr>
<tr>
<td>Text</td>
<td><img src="example.png" alt="Text Icon" /></td>
<td>Lets you type text on shared content. Participants can view the text once you finish typing it and click your mouse in the content viewer, outside the text box. To change the font, on the Edit menu, choose Font. Clicking this button again turns off the text tool.</td>
</tr>
<tr>
<td>Line</td>
<td><img src="example.png" alt="Line Icon" /></td>
<td>Lets you draw lines and arrows on shared content. For more options, click the downward-pointing arrow. Clicking this button again turns off the eraser tool.</td>
</tr>
<tr>
<td>Rectangle</td>
<td><img src="example.png" alt="Rectangle Icon" /></td>
<td>Lets you highlight text and other elements in shared content. For more options, click the downward-pointing arrow. Clicking this button again turns off the Highlighter tool.</td>
</tr>
<tr>
<td>Highlighter</td>
<td><img src="example.png" alt="Highlighter Icon" /></td>
<td>Displays the Annotation Color palette, on which you can select a color to annotate shared content. Clicking this button again closes the Annotation Color palette.</td>
</tr>
<tr>
<td>Eraser</td>
<td><img src="example.png" alt="Eraser Icon" /></td>
<td>Erases text and annotations or clears pointers on shared content. To erase a single annotation, click it in the viewer. For more options, click the downward-pointing arrow. Clicking this button again turns off the eraser tool.</td>
</tr>
</tbody>
</table>
Clearing annotations and pointers on a shared desktop or application

If you annotated a shared desktop or application, you can clear:

- All annotations at once
- Only specific annotations
- Your pointer

To clear all annotations on a shared desktop or application:
1. On the Annotation panel, click the downward-pointing arrow to the right of the Eraser button.
2. Choose **Clear All Annotations**.

To clear specific annotations on a shared desktop or application:
1. On the Annotation panel, click the Eraser button.
   Your mouse pointer changes to an eraser.
2. Click the annotation that you want to clear.

To clear your pointer:
1. On the Annotation panel, click the downward-pointing arrow to the right of the Eraser button.
2. Choose **My Pointer**.

To turn off the Eraser tool:
On the Annotation panel, click the Eraser button.

Selecting a color for annotating a shared desktop or application

If you are annotating a shared desktop or application, you can select a different color for making annotations.

To select a color for annotating a shared desktop or application:
1. On the Annotation panel, click the downward-pointing arrow to the right of the **Annotation Color** button.
The Annotation Color palette appears.

2 Click the color that you want to use.

### Taking a screen capture of your desktop

If you or a customer makes annotations on a shared desktop or application, you can save an image of your entire desktop, including all annotations and pointers, to a file in one of the following formats:

- BMP
- GIF
- JPG, JPEG

To take a screen capture of your desktop:

1. On the Annotation panel, click the Screen Capture button.

   The Save As dialog box appears.

2. Choose a location and a file format (.bmp, .gif, or .jpg) for saving the file.

3. Click Save.

### Stopping annotation mode

To return to using or remotely controlling a shared desktop or application, you must first stop annotation mode.

To stop annotation mode:

Do one of the following:

- Minimize the Annotation panel, by clicking the Minimize button in the upper-right corner of the panel.

  The Annotation icon appears on the icon tray. You can quickly re-start annotation mode by clicking this icon.

- Close the Annotation panel, by either:

  - Double-clicking the annotation tool you are using
  - Right-clicking the panel's title bar, and then choosing Close Panel
The Annotation panel closes, and the **Annotation** icon does *not* appear on the icon tray. You can re-start annotation mode by clicking the **Select Panel** button, and then choosing **Annotation**.
You can send and receive chat messages to and from a customer or another support representative. Chat is useful if you want to communicate with a customer without using a telephone. For example, if a customer's call to your technical support center is a long-distance call, you can use chat to help the customer avoid long-distance charges.

The following table describes the tasks associated with using chat. For detailed instructions on a particular task, click "More" by the task description.

<table>
<thead>
<tr>
<th>task description</th>
</tr>
</thead>
<tbody>
<tr>
<td>send chat messages More… (on page 81)</td>
</tr>
<tr>
<td>selecting quick phrases More (on page 82)</td>
</tr>
<tr>
<td>save chat messages to a file More… (on page 83)</td>
</tr>
</tbody>
</table>

### Sending chat messages

Either you or a customer can initiate a chat session.
To send chat messages:

1. Do one of the following:
   - On the CSR dashboard, click the Tools tab, and then click Chat.
   - On the floating icon tray, or in the multi-session window, click the Chat icon.

The Chat panel appears.

2. In the Send to drop-down list, select the name of the person to whom you want to send a chat message. If you want to send a message to all participants in the session, select All Participants.

3. Type a message in the box.

4. Click Send.

The recipient that you selected receives the chat message in his or her Chat panel.

Selecting quick phrases

[Note: If provisioned for your site, the Chat Phrase Library feature must be turned on by your site administrator in order for it to be available for customer support agents.]

Your site administrator can create frequently used sentences that are assigned and available to you during a support session.
To select quick phrases:

1. On the floating icon tray, or in the multi-session window, click the Chat icon.

   ![Chat Icon](image)

   The Quick Phrase message appears in the Chat box.

2. In the Send to drop-down list, select who you want to receive the chat message.

3. In the Quick Phrase drop-down list, select the frequently used sentence name.

4. Click Send.

### Saving a chat

You can save the chat messages that appear in your Chat panel to a text (.txt) file.

To save a chat:

1. On the Chat panel, click the Save button.

   ![Save Button](image)

   The Save Chat As dialog box appears.

2. Choose a location at which to save the chat file, and then click Save.
Using Video

You can use video to personalize and enhance a support session:

- Let your customer see you as you provide assistance
- If your customer can send video, talk together as if you are face to face
- Show an object under discussion

Participants in your session do not require video equipment to view your video.

<table>
<thead>
<tr>
<th>task description</th>
</tr>
</thead>
<tbody>
<tr>
<td>set up video More (on page 86)</td>
</tr>
<tr>
<td>Send video More (on page 86)</td>
</tr>
<tr>
<td>adjust video output More (on page 87)</td>
</tr>
<tr>
<td>stop video More (on page 88)</td>
</tr>
<tr>
<td>Switch to full-screen view More (on page 89)</td>
</tr>
</tbody>
</table>
Setting up video

To set up video:

Connect a webcam, also called a video camera, to your computer. Once you start a support session, WebEx automatically detects your webcam. Most webcams that connect to your computer’s USB or parallel port are compatible. The video quality can vary depending on the webcam that you use.

WebEx supports high-quality video up to 360p resolution (640x360). If your site or meeting does not support high-quality video, then standard video is used.

A system that meets the following minimum requirements can send or receive high-quality video:

<table>
<thead>
<tr>
<th>Video mode</th>
<th>What you need</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sending</td>
<td></td>
</tr>
<tr>
<td></td>
<td>▪ A webcam capable of producing high-quality video. WebEx supports most webcams of this type</td>
</tr>
<tr>
<td></td>
<td>▪ A computer with at least one GB of RAM and a dual-core processor</td>
</tr>
<tr>
<td></td>
<td>▪ A fast network connection</td>
</tr>
<tr>
<td>Receiving</td>
<td></td>
</tr>
<tr>
<td></td>
<td>▪ A computer with at least one GB of RAM and a single-core processor</td>
</tr>
<tr>
<td></td>
<td>▪ A fast network connection</td>
</tr>
</tbody>
</table>

Sending video

To send video:

1. Do one of the following:
   - On the CSR dashboard, click the Tools tab, and then select Video.
   - On the icon tray, or in the multi-session window, select the video icon. The video panel appears.

2. Select Start My Video.
Chapter 8: Using Video

CSR video panel

The CSR video appears on the small screen. If your customer sends video, the customer video appears on the big screen.

Each session supports two-point video. No matter how many participants are in the session, only two can send video: the CSR and primary customer.

Customer video panel

Your customer can send video only after you start sending video. Then the Start My Video button appears on the customer console.

The CSR video appears on the big screen and the customer video appears on the small screen.

To stop sending video, your customer simply selects Stop My Video.

Adjusting video output

When sending video during a support session you can adjust video output to control

- the quality of the video image
- the resolution, or size, of the video image
- other settings that your camera supports, such as lighting and contrast

If more than one camera is attached to your computer, you can also select the video camera that you want to use.
To adjust video output:

1. On the video panel, click **Options**.

   ![Options button](image)

   The Video Options dialog box appears.

2. Adjust options as required.

3. **Optional.** To select a different video camera, in the drop-down list under **Capture Device**, select the camera that you want to use.

Stopping video

On the video panel, select **Stop My Video**.

![Stopping video](image)

Your video streaming ceases.

You customer can no longer see your video.

If your customer is sending video you can still see it.

To resume sending video:

On the video panel, select **Start My Video**.

Video streaming starts again.

To close the video panel:

Select the minimize icon on the upper right corner of the panel.

The video panel closes

---

**Caution:** After you minimize video, you do not stop sending it. Your video icon flashes to
Switching to full-screen view

You can switch your display between the video panel and full-screen view. Full-screen view encompasses your entire screen and does not include a title bar or scroll bars.

To display video in full-screen view:

Select the Full Screen icon on the top right corner of the video panel.

To return to standard view:

Select Exit Full-Screen Mode on the top-right corner of the screen.
Setting Up a One-Click Meeting

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of starting a One-Click Meeting from your WebEx service Web site</td>
<td>About setting up a One-Click Meeting (on page 91)</td>
</tr>
<tr>
<td>specify settings for your One-Click Meeting</td>
<td>Setting up your One-Click Meeting on the Web (on page 92)</td>
</tr>
<tr>
<td>install WebEx One-Click, which includes the One-Click panel and One-Click shortcuts</td>
<td>Installing WebEx Productivity Tools (on page 96)</td>
</tr>
<tr>
<td>start a One-Click Meeting from your WebEx service Web site</td>
<td>Starting a One-Click Meeting (on page 98)</td>
</tr>
<tr>
<td>remove WebEx One-Click, including all One-Click shortcuts, from your computer</td>
<td>Removing WebEx Productivity Tools (on page 102)</td>
</tr>
</tbody>
</table>

About setting up a One-Click Meeting

WebEx One-Click allows you to start a meeting instantly from your desktop (desktop version) and from your WebEx service Web site (Web version). You can set up one or both versions, depending on your needs:

- **Web version**: allows you to start a One-Click Meeting from your WebEx service Web site. Doing so does not require you to download any application. For more information about the web version, refer to the *WebEx One-Click User’s Guide*, which is available on the Support page of your WebEx Service web site.
Chapter 9: Setting Up a One-Click Meeting

- **Desktop version:** if this feature and the Productivity Tools feature are enabled by your site administrator, allows you to start and join meetings and send meeting invitations without logging in to your WebEx service site or navigating Web pages. For more information about the desktop version, refer to the *WebEx One-Click User's Guide*.

Setting up your One-Click Meeting on the Web

The One-Click Meeting Setup page allows you to specify options a One-Click Meeting. You can return to the One-Click Meeting Setup page at any time to modify your meeting.

The settings you specify apply to both the One-Click Web version and the desktop version.

To set up your One-Click Meeting:
1. Log in to your WebEx Service Web site.
2. Click **My WebEx > Productivity Tools Setup** (on the left navigation bar).
   The Productivity Tools Setup page appears.
   On this screen, you can also download WebEx Productivity Tools, which include the desktop version of One-Click and its shortcuts. For details, see *Installing WebEx Productivity Tools* (on page 96).
3. Click **Set Up Now**.
   The One-Click Setup page appears.
4. Specify the meeting information and settings on the page.
   For details about the options on the One-Click Settings page, see *About the One-Click Settings page* (on page 93).
5. Click **Save**.

**Tip:** Whenever you want to edit options for your One-Click Meeting, return to the One-Click Settings page by clicking **My WebEx > Productivity Tools Setup > Edit Settings**.
Chapter 9: Setting Up a One-Click Meeting

About the One-Click Settings page

How to access this page:

On your WebEx service Web site, do one of the following:

- If you are setting up your One-Click Meeting for the first time, on your WebEx service Web site, click My WebEx > Productivity Tools Setup (on the left navigation bar) > Set Up Now.

- If you already set up your One-Click Meeting, on your WebEx service Web site, click My WebEx > Productivity Tools Setup (on the left navigation bar) > Edit Settings.

What you can do here:

Set options for your One-Click Meeting

Meeting Options

<table>
<thead>
<tr>
<th>Use this option…</th>
<th>To…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service type</td>
<td>Select the type of WebEx session for which you want to start a One-Click Meeting. This option lists only the session types available for your site and user account.</td>
</tr>
<tr>
<td>Meeting template</td>
<td>Select the meeting template you want to use to set options for your One-Click Meeting. The drop-down list of templates includes: <strong>Standard templates</strong>: Templates that your site administrator set up for your account. <strong>My Templates</strong>: Any personal templates that you created by saving the settings for a meeting you previously scheduled, using the scheduling options on your site.</td>
</tr>
<tr>
<td>Topic</td>
<td>Specify the topic for the meeting</td>
</tr>
<tr>
<td>Meeting password</td>
<td>Specify the password for the meeting.</td>
</tr>
<tr>
<td>Confirm password</td>
<td>Type the password again to prevent typing errors.</td>
</tr>
<tr>
<td>Ask for my approval when someone joins</td>
<td>Specify that the Request to Join dialog box appears on your screen when someone tries to join your meeting. Available for support sessions only</td>
</tr>
</tbody>
</table>
List support session on Personal Meeting Room

Specify that the support session appears on your Personal Meeting Room page. You can share with your customers the URL to this page and have them join your session from the page.

Available for support sessions only

Tracking Codes

<table>
<thead>
<tr>
<th>Use this option...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tracking code</td>
<td>Identify your department, project, or other information that your organization wants to associate with your meetings. Tracking codes can be optional or required, depending on how your site administrator set them up. If your site administrator requires you to select a code from a predefined list, click the link <strong>Select Code</strong>, and then select a code from the list or enter one in the box above.</td>
</tr>
</tbody>
</table>

Audio Conference

*meetings, training sessions, and sales meetings only*

<table>
<thead>
<tr>
<th>Use this option...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use</td>
<td>Select the type of teleconference you would like to use:</td>
</tr>
</tbody>
</table>
### Chapter 9: Setting Up a One-Click Meeting

#### Use this option... | To...
---|---
**WebEx Audio:** | Specifies that the meeting includes an integrated audio conference. If you select this option, select one of the following options:
- **Display toll-free number:** Select if your site provides toll-free call-in audio conferencing, in which both a toll-free number and a toll number are available. If your participants dial a toll-free call-in number, your organization assumes the charges for the calls. Otherwise, participants assume the charges for their calls.
- **Display global call-in numbers to attendees:** Select if you want to provide a list of numbers—such as toll-free or local numbers—that attendees in other countries can call to join the audio conference.

**Note:** After you start the meeting, participants have a choice of joining by can choose to use their computer as their audio device, using VoIP, or to use their phone as their audio device.

**Tip:** A participant must have a direct phone line to receive a call from the teleconferencing service. However, a participant without a direct phone line can join an audio conference by calling a call-in telephone number, which is always available in the Meeting window.

**Personal Conference Number Account**  | Available only if your site has the Personal Conferencing feature turned on, and only for Meeting Center.
Select the Personal Conference number account that you want to use for your meeting. You can manage your Personal Conference number accounts on the My WebEx > Personal Conferencing page.

**Cisco Unified MeetingPlace Audio Conferencing** | Available only if your site has Cisco Unified MeetingPlace Audio turned on.
If you select this option, choose the type of conference:
- **Call-in teleconference:** Select if you want customers to dial a number to join
- **Call-back teleconference:** Select if you want customers to type in a phone number and receive a call back from the conferencing service.

A participant must have a direct phone line to receive a call from the conferencing service. However, a participant without a direct phone line can join an audio conference by dialing a call-in number, which is always available in the meeting window.
## Using Other Teleconference Services

<table>
<thead>
<tr>
<th>Use this option...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Other teleconference service:</td>
<td>Specifies that the meeting includes a teleconference that another service provides, such as a third-party teleconferencing service or internal teleconferencing system, such as a PBX (private branch exchange). In the text box, type instructions for joining the teleconference.</td>
</tr>
<tr>
<td>Use VoIP Only</td>
<td>Specify that the meeting includes only Integrated VoIP, which allows meeting participants to use computers with audio capability to communicate over the Internet rather than the telephone system.</td>
</tr>
<tr>
<td>None</td>
<td>Specify that the meeting does not include either an audio conference or Integrated VoIP.</td>
</tr>
</tbody>
</table>

## Installing WebEx Productivity Tools

If your site administrator has enabled you to download WebEx Productivity Tools, you can start you can start or join meetings instantly using One-Click; start meetings instantly from other applications on your desktop, such as Microsoft Office, Web browsers, Microsoft Outlook, IBM Lotus Notes, and instant messengers; and schedule meetings using Microsoft Outlook or IBM Lotus Notes without going to your WebEx service site.

Before installing WebEx Productivity Tools, ensure that your computer meets the following minimum system requirements:

- Microsoft Windows 2000, XP, 2003, Vista
- Microsoft Internet Explorer 6.0 SP1 or 7.0, or Firefox 3.0 or later
- Intel x86 (Pentium 400MHZ +) or compatible processor
- JavaScript and cookies enabled in the browser

**To install WebEx Productivity Tools:**

1. Log in to your WebEx service Web site.
3. Click **Install Productivity Tools**. The File Download dialog box appears.
4. Save the installation program to your computer.
   The name of the installation file has an .msi extension.

5. Run the installation file and follow the instructions.

6. Once you complete installation, log in using your WebEx account information and then verify your WebEx settings for Productivity Tools, including One-Click, in the WebEx Settings dialog box.

   **Note:** System administrators can also perform a mass installation for computers at their site. For more information, see the IT Administrator Guide for Mass Deployment of WebEx Productivity Tools at [http://support.webex.com/US/PT/wx_pt_ag.pdf](http://support.webex.com/US/PT/wx_pt_ag.pdf).

After you have logged in, the WebEx One-Click panel and shortcuts appear. For instructions about using the One-Click panel and shortcuts, see the *WebEx One-Click User's Guide*.

The Help in the WebEx One-Click panel also provides detailed information about how to use the One-Click panel and shortcuts.

![Open One-Click](image)

**Tip:** For instructions on using the WebEx One-Click panel and the One-Click taskbar menu, refer to the *WebEx One-Click User's Guide*, which is available on the Support page of your WebEx Service web site.
Starting a One-Click Meeting

Before you start a One-Click Meeting from your WebEx Service Web site, ensure that you set up One-Click settings. For details about setting up One-Click settings, see Setting up your One-Click Meeting on the Web (on page 92).

To start a One-Click Meeting from your WebEx service Web site:

1. Log in to your WebEx Service Web site.
2. Click My WebEx > Start One-Click Meeting.

Your meeting starts.

To start a One-Click Meeting using the WebEx One-Click panel:

1. Open your WebEx One-Click panel by doing any of the following:
   - Double-click the WebEx One-Click shortcut on your desktop.
   - Go to Start > Programs > WebEx > Productivity Tools > WebEx One-Click.
   - Right-click the WebEx One-Click icon on the taskbar of your desktop.

   If you did not specify automatic login, enter the required WebEx account information in the dialog box, and then click Log In.

2. On the WebEx One-Click panel, click Start Meeting.
To start a One-Click Meeting using a One-Click shortcut:

Click one of the following shortcuts:

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Open One-Click</strong></td>
<td><strong>Right-click menu of taskbar icon shortcut:</strong></td>
</tr>
<tr>
<td>Start Meeting Now</td>
<td>▪ Right-click the WebEx One-Click taskbar icon and then click <strong>Start meeting now</strong> to start an instant meeting.</td>
</tr>
<tr>
<td>Start Personal Conference Meeting</td>
<td>▪ Right-click the WebEx One-Click taskbar icon and then click <strong>Start a Scheduled Meeting</strong> to start a previously scheduled meeting, or click <strong>Start Personal Conference meeting</strong> to start a previously scheduled Personal Conference meeting.</td>
</tr>
<tr>
<td>Schedule a Meeting...</td>
<td><strong>Note:</strong> You can also right-click the WebEx One-Click taskbar icon and then click <strong>Schedule a meeting</strong> to schedule a WebEx meeting using Microsoft Outlook or Lotus Notes.</td>
</tr>
<tr>
<td>Join a Meeting...</td>
<td>For more details, see the <strong>Integration to Outlook User's Guide</strong> and the <strong>Integration to Lotus Notes User's Guide</strong>, which are available on the Support page of your WebEx Service.</td>
</tr>
<tr>
<td>Connect to My Computers...</td>
<td></td>
</tr>
<tr>
<td>WebEx Settings...</td>
<td></td>
</tr>
<tr>
<td>Help</td>
<td>F1</td>
</tr>
<tr>
<td>About WebEx One-Click...</td>
<td></td>
</tr>
<tr>
<td>Exit</td>
<td></td>
</tr>
</tbody>
</table>
Chapter 9: Setting Up a One-Click Meeting

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>web site.</td>
<td></td>
</tr>
</tbody>
</table>

**Email and Scheduling shortcut:** Click **One-Click Meeting** in Microsoft Outlook or Lotus Notes to start a One-Click meeting.

**Note:** You can also click **Schedule Meeting** in Microsoft Outlook or Lotus Notes to schedule a WebEx meeting using Outlook or Lotus Notes.

For more details, see the **Integration to Outlook User's Guide** and the **Integration to Lotus Notes User's Guide**, which are available on the Support page of your WebEx Service web site.

**Instant messenger shortcut:** Click **WebEx > Start WebEx Meeting** to start a One-Click meeting in your instant messenger, such as Skype, AOL Instant Messenger, Lotus SameTime, Windows Messenger, Google Talk, or Yahoo Messenger. For more details, see the **Integration to Instant Messengers Guide**, which is available on the Support page of your WebEx Service web site.

Available for meetings, sales meetings, training sessions, and support sessions only.
Chapter 9: Setting Up a One-Click Meeting

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Web browser shortcut" /></td>
<td><strong>Web browser shortcut:</strong> Click this icon to start your meeting. <strong>Note</strong> If you previously customized your Internet Explorer toolbar, the shortcut button may not automatically appear on the toolbar. Instead, it is added to the list of available toolbar buttons in Internet Explorer. In this case, you must add the button to the toolbar, using the Internet Explorer <strong>Customize</strong> option. To access this option, on the <strong>View</strong> menu, point to <strong>Toolbars</strong>, and then choose <strong>Customize</strong>. Available for meetings, sales meetings, training sessions, and support sessions only.</td>
</tr>
<tr>
<td><img src="image" alt="Microsoft Office shortcut" /></td>
<td><strong>Microsoft Office shortcut:</strong> In Microsoft Word, Microsoft Excel, and Microsoft PowerPoint, select <strong>Share As Document</strong> or <strong>Share As Application</strong>. This command starts the meeting and automatically shares the application you are using, including all files that are already open in that application. You can still work in the application during the meeting. Available for meetings, sales meetings, training sessions, and support sessions only.</td>
</tr>
<tr>
<td><img src="image" alt="Right-Click menu shortcut" /></td>
<td><strong>Right-Click menu shortcut:</strong> Right-click the icon for an application or document file on your computer, and then point to <strong>Share in WebEx Meeting</strong> &gt; <strong>As Application</strong>. This command starts the meeting and automatically shares the application, including all files that are already open in that application. You can still work in the application during the meeting. Available for meetings, sales meetings, training sessions, and support sessions only.</td>
</tr>
</tbody>
</table>

**Tip:**
- Once you start a One-Click Meeting, it appears on your Personal Meeting Room page, unless you specified it to be an unlisted meeting. If you provide others with the URL for this page, they can quickly join your meeting by clicking the link for the meeting on this page.
- You can control which shortcuts are available in the WebEx Settings dialog box.
- For instructions on using the WebEx One-Click shortcuts, refer to the **WebEx One-Click User’s Guide**.
Removing WebEx Productivity Tools

You can uninstall WebEx Productivity Tools at any time. Uninstalling Productivity Tools removes all Productivity Tools, including the WebEx One-Click panel and One-Click shortcuts, from your computer.

To uninstall WebEx Productivity Tools:

1. Click **Start > Programs> WebEx > Productivity Tools > Uninstall**
2. Click **Yes** to confirm that you want to uninstall WebEx Productivity Tools.

To uninstall WebEx Productivity Tools from the Control Panel:

1. Click **Start > Settings > Control Panel**.
2. Double-click **Add/Remove Programs**.
3. Click **WebEx Productivity Tools**.
4. Click **Remove**.
5. Click **Yes** to confirm that you want to uninstall WebEx Productivity Tools.

**Note:** Uninstalling Productivity Tools removes all Productivity Tools and shortcuts from your computer. If you want to keep using some Productivity Tools but disable others, edit the options in the WebEx Settings dialog box.
## Using My WebEx

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>See…</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of My WebEx</td>
<td>About My WebEx (on page 104)</td>
</tr>
<tr>
<td>set up a user account on your WebEx service Web site</td>
<td>Obtaining a user account (on page 105)</td>
</tr>
<tr>
<td>log in to or out from My WebEx</td>
<td>Logging in to and out of the WebEx service site (on page 106)</td>
</tr>
<tr>
<td>use your list of meetings</td>
<td>Using your list of meetings (on page 106)</td>
</tr>
<tr>
<td>Install WebEx Productivity Tools, which let you start One-Click meetings, start instant meetings from applications on your desktop, or schedule meetings from Microsoft Outlook or IBM Lotus Notes</td>
<td>Installing WebEx Productivity Tools (on page 96)</td>
</tr>
<tr>
<td>set up a One-Click Meeting</td>
<td>Setting Up a One-Click Meeting (on page 91)</td>
</tr>
<tr>
<td>view or set options for your Personal Meeting Room page</td>
<td>Maintaining Your Personal Meeting Room Page (on page 115)</td>
</tr>
<tr>
<td>set up or access remote computers, using Access Anywhere</td>
<td>Using Access Anywhere (My Computers) (on page 118)</td>
</tr>
<tr>
<td>add, edit, or delete files in your personal storage space for files</td>
<td>Maintaining files in your personal folders (on page 120)</td>
</tr>
<tr>
<td>add, edit, or delete information about your contacts in your online address book</td>
<td>Maintaining contact information (on page 137)</td>
</tr>
<tr>
<td>change information or settings in your user profile, including personal information and preferences</td>
<td>Maintaining your user profile (on page 152)</td>
</tr>
</tbody>
</table>
About My WebEx

My WebEx is an area on your WebEx service Web site in which you can access your user account and personal productivity features. The following features are available, depending on the configuration of your site and user account:

- **Personal list of meetings**: Provides a list of all the online meetings that you are hosting and attending. You can view the meetings by day, week, or month, or you can view all meetings.

- **Productivity Tools Setup**: Optional feature. Lets you set up options for instant or scheduled meetings that you can start from applications on your desktop. If you install WebEx Productivity Tools, you can start or join meetings, sales meetings, training sessions, and support sessions instantly from One-Click or from other applications on your desktop, such as Microsoft Office, Web browsers, Microsoft Outlook, IBM Lotus Notes, and instant messengers. You can also schedule meetings, sales meetings, events, and training sessions using Microsoft Outlook or IBM Lotus Notes without going to your WebEx service site.

- **Personal Meeting Room**: Optional feature. A page on your WebEx service Web site on which visitors can view a list of meetings that you are hosting and join a meeting in progress. Visitors can also access and download files that you share.

- **Access Anywhere**: Optional feature. Lets you access and control a remote computer from anywhere in the world. For more information about Access Anywhere, refer to the guide Getting Started with Access Anywhere, which is available on your WebEx service Web site.

- **File storage**: Lets you store files in personal folders on your WebEx service Web site, where you can access them on any computer that has access to the Internet. Also lets you make specific files available on your Personal Meeting Room page, so visitors to your page can access them.

- **Address book**: Lets you keep information about your personal contacts on your WebEx service Web site. Using your address book, you can quickly access contacts when inviting them to a meeting.
Chapter 10: Using My WebEx

- **User profile:** Lets you maintain your account information, such as your username, password, and contact information. Also lets you specify another user who can schedule meetings on your behalf, set options for your Personal Meeting Room page, and manage scheduling templates.

- **Web site preferences:** Lets you specify the home page for your WebEx service Web site—that is, the page that appears first whenever you access your site. If your site provides multiple languages, you can also choose a language and locale in which to display text on your site.

- **Usage reports:** Optional feature. Lets you obtain information about meetings that you hosted. If you use the Access Anywhere option, you can also obtain information about computers that you access remotely.

### Obtaining a user account

Once you obtain a user account, you can use My WebEx features and hosts on the Web.

You can obtain a user account in one of two ways:

- The site administrator for your WebEx service Web site can create a user account for you. In this case, you need not sign up for an account on your site, and you can begin hosting sessions immediately.

- If your site administrator has made the self-registration feature available, you can sign up for an account on your WebEx service Web site at any time.

#### To obtain a user account using the self-registration feature:

1. Go to your WebEx service Web site.
2. On the navigation bar, click **Set Up > New Account**.
   - The Sign Up page appears.
3. Provide the required information.
4. Click **Sign Up Now**.
   - You receive an email message, confirming that you have signed up for a user account.
   - Once your site administrator approves your new user account, you receive another email message containing your username and password.
Note: Once you obtain a user account, you can edit your user profile to change your password and provide additional personal information. You can also specify site preferences, such as your default home page and time zone. For details, see Maintaining your user profile (on page 152).

Log in to and out of the WebEx service site

To manage your online meetings and maintain your user account, you must log in to your WebEx service Web site. If you do not yet have a user account, see Obtaining a user account (on page 105).

To log in to your WebEx service site:

1. Go to your WebEx service Web site.
2. In the upper-right corner of the page, click Log In.
   The Log In page appears.
3. Enter your username and password.
   Passwords are case-sensitive, so you must type your password exactly as you specified it in your user profile.
4. Click Log In.

Tip: If you have forgotten your username or password, click Forgot your password. Provide your email address, type verification characters, and then click Submit. You will receive an email message containing your username and password.

To log out from your WebEx service site:

In the upper-right corner of the page, click Log Out.

Using your list of meetings

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>See…</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of your list of meetings</td>
<td>About your list of meetings</td>
</tr>
<tr>
<td>open your list of meetings</td>
<td>Opening your meetings list</td>
</tr>
</tbody>
</table>

(107)
If you want to... | See...
---|---
maintain your list of meetings | Maintaining your scheduled meetings list

### About your list of meetings

On your WebEx service Web site, your My Meetings page in My WebEx includes:

- Any support sessions that you are currently conducting.
- An option to start a One-Click meeting (not available for Event Center).
- Any Personal Conference meetings that you scheduled (if your site and account have the Personal Conferencing feature turned on).

**Tip:** You can specify that your My WebEx meetings page is the home page that appears once you log in to your WebEx service Web site. For details, see *Maintaining your user profile* (on page 152).

### Opening your meetings list

Your list of meetings, which appears on your My Meetings page on your Support Center Web site, shows any support sessions that you are currently conducting.

**To open your meetings list:**

Log in to your WebEx service Web site, and then click My WebEx.

The My Meetings List shows your active support sessions.

**Tip:** You can specify that your My WebEx Meetings page is the home page that appears once you log in to your WebEx service Web site. For details, see *Maintaining your user profile* (on page 152).
Maintaining your scheduled meetings list

Once you start a support session, it appears on your meetings list. For more information, see Opening your meetings list (on page 107).

A support session remains on your list of meetings until you end the session.

For details about the options on the My WebEx Meetings page, see About the My WebEx Meetings page (on page 108).

About the My WebEx Meetings page

How to access this tab

On your WebEx service Web site, click the My WebEx tab.

What you can do here

Access these features:

- A link to your personal meeting room
- A list of meetings you are hosting or are invited to for the specified day, week, or month
- A list of all meetings you are hosting or are invited to
- A link to start a One-Click meeting

Options on this page

<table>
<thead>
<tr>
<th>Use this option…</th>
<th>To…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Go To My Personal Meeting Room</td>
<td>Go to your Personal Meeting Room page.</td>
</tr>
<tr>
<td></td>
<td>Your Personal Meeting Room page lists any meetings that you scheduled and any in-progress meetings that you are currently hosting.</td>
</tr>
<tr>
<td></td>
<td>Users to whom you provide your personal URL can use this page to join any meeting that you are hosting. They can also download files in any folders that you share.</td>
</tr>
</tbody>
</table>
### Start a One-Click Meeting

Start a One-Click Meeting based on settings you have specified in [One-Click Setup](#). For details, see [Setting Up a One-Click Meeting](#) (on page 91).

### Daily

View a list all of the meetings for the specified day. For details, see [About the My WebEx Meetings - Daily tab](#) (on page 109).

### Weekly

View a list all of the meetings for the specified week. For details, see [About the My WebEx Meetings - Weekly tab](#) (on page 110).

### Monthly

View a list all of the meetings for the specified month. For details, see [About the My WebEx Meetings - Monthly tab](#) (on page 112).

### All Meetings

View a list all meetings, or search for meetings by date, host, topic, or words in the agenda. For details, see [About the My WebEx Meetings - All Meetings tab](#) (on page 113).

### Refresh

Refresh the information in the meeting list.

## About the My WebEx Meetings page - Daily tab

### How to access this tab

On your WebEx service Web site, click **My WebEx > My Meetings > Daily tab**.

### Options on this tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Click the Refresh icon at any time to display the most current list of meetings.</td>
</tr>
<tr>
<td>Language link</td>
<td>Click to open the Preferences page, where you can select the language setting for your WebEx service Web site.</td>
</tr>
<tr>
<td>Time zone link</td>
<td>Click to open the Preferences page, where you can select the time zone setting for your WebEx service Web site.</td>
</tr>
<tr>
<td>Date</td>
<td>The date for the daily list of meetings. The default is the current date.</td>
</tr>
</tbody>
</table>
### Option | Description
--- | ---
Click the **Previous Day** icon to display a list of meetings for the previous day. | 
Click the **Next Day** icon to display a list of meetings for the next day. | 
**The meetings you host** Shows a list all of the online meetings or Personal Conference meetings that you are hosting. | 
**The meetings you are invited to** Shows a list all of the meetings or Personal Conference meetings to which you have been invited. | 
**Show past meetings** Select to include concluded meetings in the list of meetings. | 
The **Ascending Sort** indicator appears next to a column heading, and the meetings are sorted by the column, in ascending order. | 
The **Descending Sort** indicator appears next to a column heading, and the meetings are sorted by the column, in descending order. | 
**Time** The starting time for each scheduled meeting. Click the box next to a meeting start time to select that meeting. Click the box next to the **Time** column heading to select or clear all meetings in the list. | 
**Topic** The topic for a meeting that you are hosting. Click the topic name to get information about that meeting. | 
**Type** Indicates the type of online meeting that you are hosting. Available meeting types depend on the configuration of your WebEx service Web site. | 
The **in process** indicator indicates that the live meeting is in process. | 

### About the My WebEx Meetings page - Weekly tab

#### How to access this tab

On your WebEx service Web site, click **My WebEx > My Meetings > Weekly** tab.
### Options on this tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click the <strong>Refresh</strong> icon</td>
<td>Click the Refresh icon at any time to display the most current list of meetings.</td>
</tr>
<tr>
<td>Language link</td>
<td>Click to open the Preferences page, where you can select the language setting for your WebEx service Web site.</td>
</tr>
<tr>
<td>Time zone link</td>
<td>Click to open the Preferences page, where you can select the time zone setting for your WebEx service Web site.</td>
</tr>
<tr>
<td>Week link</td>
<td>The beginning and ending date for the weekly list of meetings.</td>
</tr>
<tr>
<td>Click the Previous Week icon</td>
<td>Click the Previous Week icon to display a list of meetings for the previous week.</td>
</tr>
<tr>
<td>Click the Next Week icon</td>
<td>Click the Next Week icon to display a list of meetings for the next week.</td>
</tr>
<tr>
<td>Click the Calendar icon</td>
<td>Click the Calendar icon to open the Calendar window for the current month. Click on any date to open its schedule in the Daily view.</td>
</tr>
<tr>
<td>The meetings you host</td>
<td>Shows a list all of the online meetings or Personal Conference meetings that you are hosting.</td>
</tr>
<tr>
<td>The meetings you are invited to</td>
<td>Shows a list all of the meetings or Personal Conference meetings to which you have been invited.</td>
</tr>
<tr>
<td>Show past meetings</td>
<td>Select to include concluded meetings in the list of meetings.</td>
</tr>
<tr>
<td>Day link</td>
<td>Opens the Daily view, which shows the scheduled meetings for the selected day.</td>
</tr>
<tr>
<td>Friday</td>
<td>The Ascending Sort indicator appears next to a column heading, and the meetings are sorted by the column, in ascending order.</td>
</tr>
<tr>
<td></td>
<td>The Descending Sort indicator appears next to a column heading, and the meetings are sorted by the column, in descending order.</td>
</tr>
<tr>
<td></td>
<td>The Expand button appears next to a Day link. Click this button to expand and display the list of meetings for that day.</td>
</tr>
<tr>
<td></td>
<td>The Collapse button appears next to a Day link. Click this button to collapse and hide the list of meetings for that day.</td>
</tr>
</tbody>
</table>
Chapter 10: Using My WebEx

### About the My WebEx Meetings page - Monthly tab

#### How to access this tab

On your WebEx service Web site, click **My WebEx > My Meetings > Monthly** tab.

#### Options on this tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time</td>
<td>The starting time for each scheduled meeting. Click the box next to a meeting start time to select that meeting. Click the box next to the <strong>Time</strong> column heading to select or clear all meetings in the list.</td>
</tr>
<tr>
<td>Topic</td>
<td>The topic for a meeting that you are hosting. Click the topic name to get information about that meeting.</td>
</tr>
<tr>
<td>Type</td>
<td>Indicates the type of online meeting that you are hosting. Available meeting types depend on the configuration of your WebEx service Web site.</td>
</tr>
<tr>
<td></td>
<td>Indicates that the live meeting is in process.</td>
</tr>
</tbody>
</table>

---

The following options are provided on the monthly tab:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Refresh icon" /></td>
<td>Click the <strong>Refresh</strong> icon at any time to display the most current list of meetings.</td>
</tr>
<tr>
<td>Language link</td>
<td>Click to open the Preferences page, where you can select the language setting for your WebEx service Web site.</td>
</tr>
<tr>
<td>Time zone link</td>
<td>Click to open the Preferences page, where you can select the time zone setting for your WebEx service Web site.</td>
</tr>
<tr>
<td>Month</td>
<td>The month for the monthly calendar of meetings. The default is the current month.</td>
</tr>
<tr>
<td><img src="image" alt="Previous Month icon" /></td>
<td>Click the <strong>Previous Month</strong> icon to display a list of meetings for the previous month.</td>
</tr>
<tr>
<td><img src="image" alt="Next Month icon" /></td>
<td>Click the <strong>Next Month</strong> icon to display a list of meetings for the next month.</td>
</tr>
</tbody>
</table>
Chapter 10: Using My WebEx

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calendar icon</td>
<td>Click the Calendar icon to open the Calendar window for the current month. Click on any date to open its schedule in the Daily view.</td>
</tr>
<tr>
<td>Week Number link</td>
<td>Opens the Weekly view, which shows the scheduled meetings for each day of the selected week.</td>
</tr>
<tr>
<td>Day link</td>
<td>Opens the Daily view, which shows the scheduled meetings for the selected day.</td>
</tr>
<tr>
<td>The meetings you host</td>
<td>Shows a list all of the online meetings or Personal Conference meetings that you are hosting.</td>
</tr>
<tr>
<td>The meetings you are invited to</td>
<td>Shows a list all of the meetings or Personal Conference meetings to which you have been invited.</td>
</tr>
<tr>
<td>Show past meetings</td>
<td>Select to include concluded meetings in the list of meetings.</td>
</tr>
<tr>
<td>Topic</td>
<td>The topic for a meeting that you are hosting. Click the topic name to get information about that meeting.</td>
</tr>
<tr>
<td></td>
<td>Indicates that the live meeting is in process.</td>
</tr>
</tbody>
</table>

About the My WebEx Meetings page - All Meetings tab

How to access this tab
On your WebEx service Web site, click My WebEx > My Meetings > All Meetings tab.

Options on this tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Refresh icon</td>
<td>Click the Refresh icon at any time to display the most current list of meetings.</td>
</tr>
<tr>
<td>Language link</td>
<td>Click to open the Preferences page, where you can select the language setting for your WebEx service Web site.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Time zone link</td>
<td>Click to open the Preferences page, where you can select the time zone setting for your WebEx service Web site.</td>
</tr>
<tr>
<td>Date</td>
<td>The date for the daily list of meetings. The default is the current date.</td>
</tr>
<tr>
<td>![Previous Day icon]</td>
<td>Click the Previous Day icon to display a list of meetings for the previous day.</td>
</tr>
<tr>
<td>![Next Day icon]</td>
<td>Click the Next Day icon to display a list of meetings for the next day.</td>
</tr>
<tr>
<td>Search for meetings by date, host, topic, or words in the agenda</td>
<td>Allows you type or select a date range to search for meetings, or allows you to type text to search in host names, topics, or agendas. Click Search to start the search.</td>
</tr>
<tr>
<td>![Calendar icon]</td>
<td>Click the Calendar icon to open the Calendar window. Click on any date to select that date as part of your search criteria.</td>
</tr>
<tr>
<td>The meetings you host</td>
<td>Shows a list all of the online meetings or Personal Conference meetings that you are hosting.</td>
</tr>
<tr>
<td>The meetings you are invited to</td>
<td>Shows a list all of the meetings or Personal Conference meetings to which you have been invited.</td>
</tr>
<tr>
<td>Show past meetings</td>
<td>Select to include concluded meetings in the list of meetings.</td>
</tr>
<tr>
<td>![Ascending Sort]</td>
<td>The Ascending Sort indicator appears next to a column heading, and the meetings are sorted by the column, in ascending order.</td>
</tr>
<tr>
<td>![Descending Sort]</td>
<td>The Descending Sort indicator appears next to a column heading, and the meetings are sorted by the column, in descending order.</td>
</tr>
<tr>
<td>Time</td>
<td>The starting time for each scheduled meeting. Click the box next to a meeting start time to select that meeting. Click the box next to the Time column heading to select or clear all meetings in the list.</td>
</tr>
<tr>
<td>Topic</td>
<td>The topic for a meeting that you are hosting. Click the topic name to get information about that meeting.</td>
</tr>
<tr>
<td>Type</td>
<td>Indicates the type of online meeting that you are hosting. Available meeting types depend on the configuration of your WebEx service Web site.</td>
</tr>
<tr>
<td>![Live Meeting]</td>
<td>Indicates that the live meeting is in process.</td>
</tr>
</tbody>
</table>
Maintaining Your Personal Meeting Room Page

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of your Personal Meeting Room page</td>
<td>About your Personal Meeting Room (on page 115)</td>
</tr>
<tr>
<td>access your Personal Meeting Room page</td>
<td>Viewing your Personal Meeting Room (on page 116)</td>
</tr>
<tr>
<td>add images and text to your Personal Meeting Room page</td>
<td>Setting options for your Personal Meeting Room (on page 116)</td>
</tr>
<tr>
<td>share files on your Personal Meeting Room page</td>
<td>Sharing files on your Personal Meeting Room (on page 117)</td>
</tr>
</tbody>
</table>

About your Personal Meeting Room page

Your user account includes a Personal Meeting Room page on your WebEx service Web site. Users who visit your page can:

- View a list of online meetings that you are hosting, either scheduled or in progress.
- Join a meeting in progress.
- View your personal folders and upload or download files to or from your folders, depending on the settings you specify for your folders.

You can customize your Personal Meeting Room page by adding images and text to it.

To provide users with access to your Personal Meeting Room page, you must provide them with your Personal Meeting Room URL. For more information, see Viewing your Personal Meeting Room page (on page 116).

Tip: Add your Personal Meeting Room URL to your business cards, your email signature, and so on.
Chapter 10: Using My WebEx

Viewing your Personal Meeting Room page

You can view your Personal Meeting Room page at any time, by going to the link for the page. The link for your Personal Meeting Room page is available on your:

- My WebEx Meetings page
- My WebEx Profile page

To view your Personal Meeting Room page:

1. Log in to your WebEx service Web site, and then click My WebEx.
   The My WebEx Meetings page appears.
2. Click the Go to My Personal Meeting Room link.
   Alternatively, in My WebEx, click My Profile, and then click the Personal Meeting Room URL link in the Personal Meeting Room section.
   Your Personal Meeting Room page appears. The following is an example of a Personal Meeting Room page.

   Tip: Add your Personal Meeting Room URL to your business cards, your email signature, and so on.

Setting options for your Personal Meeting Room page

You can add the following to your Personal Meeting Room page:

- An image (for example, you can add a picture of yourself or your company’s product).
A custom banner image to the header area of your Personal Meeting Room page, if your user account has the “branding” option. For example, you can add your company's logo.

A welcome message. For example, you can provide a greeting; instructions on joining an online session; information about yourself, your product, or your company.

At any time, you can replace or delete images and text that you add.

To add an image to your Personal Meeting Room page:
1. If you have not already done so, log in to your WebEx service Web site. For details, see *Logging in to and out of the WebEx service site* (on page 106).
2. On the navigation bar at the top of the page, click **My WebEx**.
3. Click **My Profile**.
   The My WebEx Profile page appears.
4. Under **Personal Meeting Room**, specify options for your page.
5. At the bottom of the My WebEx Profile page, click **Update**.
6. For details about the options for your Personal Meeting Room page, see *About your Personal Meeting Room page* (on page 115).

**Sharing files on your Personal Meeting Room page**

You can share folders on your My WebEx Files: Folders page so that they appear on the **Files** tab on your Personal Meeting Room page. For any folder that you share, you can specify whether users can download files from or upload files to the folder.

For more information about your Personal Meeting Room page, see *About your Personal Meeting Room page* (on page 115).

To share files on your Personal Meeting Room page:
1. Open the My WebEx Files page. For details, see *Opening your personal folders, documents, and files* (on page 121).
2. Under **Name**, locate the folder in which you want to share files.
3. If the file or folder is in a closed folder, click the folder to open it.
4. Click the **Properties** icon for the folder in which you want to share files.
Chapter 10: Using My WebEx

The Edit Folder Properties window appears.

5 Specify sharing options for the folder.

6 Click Update.

For details about sharing options, see About the Edit Folder Properties page (on page 129).

Using Access Anywhere (My Computers)

For information about and instructions for using Access Anywhere to set up and access a remote computer, please refer to the guide Getting Started with WebEx Access Anywhere. This guide is available on the Support page on your WebEx service Web site.
About the My Computers page

How to access this page
On your WebEx service Web site, click My WebEx Files > My Computers.

What you can do here
Set up and access remote computers using Access Anywhere.

Options on this page

<table>
<thead>
<tr>
<th>Link or option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Computer</td>
<td>The name you have assigned to your remote computer.</td>
</tr>
<tr>
<td>Status</td>
<td>The status of your remote computer:</td>
</tr>
<tr>
<td></td>
<td>- Available—the computer is available for remote access.</td>
</tr>
<tr>
<td></td>
<td>- Offline—the computer is offline and is not available for remote access.</td>
</tr>
<tr>
<td>Application</td>
<td>The application on your remote computer that you have allowed to access,</td>
</tr>
<tr>
<td></td>
<td>based on what you specified during set up.</td>
</tr>
<tr>
<td></td>
<td>It may be Desktop, if you set up your desktop for access, or it may be a</td>
</tr>
<tr>
<td></td>
<td>specific application name.</td>
</tr>
<tr>
<td>Status</td>
<td>If the computer is available for access, you can click the Connect link to</td>
</tr>
<tr>
<td></td>
<td>connect to your remote computer.</td>
</tr>
<tr>
<td>Remove</td>
<td>Removes the selected computer from the list of remote computers.</td>
</tr>
<tr>
<td>Set Up Computer</td>
<td>Sets up the current computer for Access Anywhere and adds it to the list of</td>
</tr>
<tr>
<td></td>
<td>remote computers.</td>
</tr>
<tr>
<td>Download manual installer</td>
<td>Downloads the manual installer for the Access Anywhere software.</td>
</tr>
</tbody>
</table>
Maintaining files in your personal folders

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>See…</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of your personal storage</td>
<td>About maintaining files in your folders (on page 120)</td>
</tr>
<tr>
<td>space for files</td>
<td></td>
</tr>
<tr>
<td>open your personal storage space for files</td>
<td>Opening your personal folders, documents, and files (on page 121)</td>
</tr>
<tr>
<td>create new folders to organize your files</td>
<td>Adding new folders to your personal folders (on page 122)</td>
</tr>
<tr>
<td>upload files to your personal folders</td>
<td>Uploading files to your personal folders (on page 123)</td>
</tr>
<tr>
<td>move or copy files or an entire folder to</td>
<td>Moving or copying files or folders in your personal folders (on page</td>
</tr>
<tr>
<td>another folder</td>
<td>124)</td>
</tr>
<tr>
<td>change information about files or folders,</td>
<td>Editing information about files or folders in your personal folders</td>
</tr>
<tr>
<td>including their names or descriptions</td>
<td>(on page 124)</td>
</tr>
<tr>
<td>search for files or folders in your</td>
<td>Searching for files or folders in your personal folders (on page 125)</td>
</tr>
<tr>
<td>storage space for files</td>
<td></td>
</tr>
<tr>
<td>download files in your personal storage</td>
<td>Downloading files in your personal folders (on page 126)</td>
</tr>
<tr>
<td>space to your computer</td>
<td></td>
</tr>
<tr>
<td>share, or publish, files in your personal</td>
<td>Sharing files on your Personal Meeting Room page (on page 117)</td>
</tr>
<tr>
<td>folders on your Personal Meeting Room, so</td>
<td></td>
</tr>
<tr>
<td>others can access them</td>
<td></td>
</tr>
<tr>
<td>remove files or folders from your personal</td>
<td>Deleting files or folders in your personal folders (on page 126)</td>
</tr>
<tr>
<td>folders</td>
<td></td>
</tr>
</tbody>
</table>

About maintaining files in your folders

Your user account includes personal storage space for files on your WebEx service Web site.

In your personal storage space, you can:

- Create folders to organize your files.
- Edit information about any file or folder in your personal folders.
- Move or copy a file or folder to a different folder.
Share a folder so it appears on your Personal Meeting Room page.

Tip:
- You can use this storage space to access important information when you are away from the office. For example, if you are on a business trip and want to share a file during an online session, you can download the file in your personal folders to a computer, and then share the file with attendees.
- If you share a folder, visitors to your Personal Meeting Room page can upload files to or download them from the folder. For example, you can use your personal folders to exchange documents that you share in your sessions, archive recorded meetings, and so on. For more information about your Personal Meeting Room, see About your Personal Meeting Room (on page 115).

Opening your personal folders, documents, and files

To store files on your WebEx service Web site, or to access files that you stored, you must open your personal folders.

**To open your personal folders:**

1. Log in to your WebEx service Web site, and then click **My WebEx**.
2. Click **My Files**.

   The My WebEx Files page appears, showing your personal folders and files. Depending on the settings for your WebEx Service Web site, you may see different categories of folders and files, and you can click on the heading links to see each category:

   - **My Documents**
   - **My Recordings**
   - **My Event Recordings** (available only in Event Center)
   - **My Training Recordings** (available only in Training Center)
Chapter 10: Using My WebEx

For details about the My WebEx Files page, see About the My WebEx Files > My Documents page (on page 127) and About the My WebEx Files > My Recordings page (on page 136).

Adding new folders to your personal folders

To organize your files on your WebEx service Web site, you can create folders in your personal storage space for files.

To create a new folder:

1. Open the My Documents page. For details, see Opening your personal folders, documents, and files (on page 121).

2. Under Action, click the Create Folder button for the folder in which you want a new folder.

The Create Folder window appears.

3. In the Folder Name box, type a name for the folder.

4. Optional. In the Description box, type a description to help you to identify the folder's contents.

5. Click OK.
Uploading files to your personal folders

To store files in your personal folders on your WebEx service Web site, you must upload them from your computer or a local server.

You can upload up to three files at once. There is no limit to the size of the files, as long as you have available storage space. The amount of space available for storing files is determined by your site administrator. If you require more disk space, contact your site administrator.

To upload files to your personal folders:

1. Open the My Documents page. For details, see Opening your personal folders, documents, and files (on page 121).
2. Locate the folder in which you want to store the file.
3. Under Action for the folder, click the Upload button for the folder in which you want to store the file.

   The Upload File window appears.

4. Click Browse.

   The Choose File dialog box appears.

5. Select the file that you want to upload to your folder.

6. Click Open.

   The file appears in the File name box.

7. Optional. In the Description box, type a description to help you identify the file.

8. Optional. Select up to two additional files to upload.

9. Click Upload.

   The files are uploaded to the folder that you selected.

10. Once you are finished uploading files, click Finish.
Moving or copying files or folders in your personal folders

You can move one or more files or folders to another folder on your WebEx service Web site.

To move or copy a file or folder:
1. Open the My Documents page. For details, see Opening your personal folders, documents, and files (on page 121).
2. Locate the file or folder that you want to move.
3. Select the check box for the file or folder that you want move.
   You can select multiple files or folders.
4. Click Move or Copy.
   The Move/Copy File or Folder window appears, showing a list of your folders.
5. Select the option button for the folder in which you want to move or copy the file or folder.
6. Click OK.

Editing information about files or folders in your personal folders

You can edit the following information about a file or folder in your personal folders on your WebEx service Web site:

- Name
- Description

You can also specify sharing options for folders that appear on your Personal Meeting Room page. For more information, see Sharing files on your Personal Meeting Room page (on page 117).

To edit information about a file or folder:
1. Open the My Documents page. For details, see Opening your personal folders, documents, and files (on page 121).
2. Locate the file or folder for which you want to edit information.
3. Click the **Properties** icon for the file or folder for which you want to edit information.

The Edit File Properties or Edit Folder Properties window appears.

- In the **Description** box, type a new name for the file or folder.
- In the **Name** box, type a new name for the file or folder.

4. Click **Update**.

### Searching for files or folders in your personal folders

In your personal folders on your WebEx service Web site, you can quickly locate a file or folder by searching for it. You can search for a file or folder by text that appears in either its name or description.

**To search for a file or folder:**

1. Open the My Documents page. For details, see *Opening your personal folders, documents, and files* (on page 121).

2. In the **Search For** box type all or part of the file's name or description.
3 Click **Search**.
   A list of any files or folders that contain the search text appears.

### Downloading files in your personal folders

In your personal folders on your WebEx service Web site, you can download any files to your computer or a local server.

1. Open the My Documents page. For details, see *Opening your personal folders, documents, and files* (on page 121).
2. Locate the file that you want to download.
3. Under **Action**, click the **Download** button for the file that you want to download.

   ![Download button](download_icon.png)

   The File Download dialog box appears.
4. Follow any instructions that your Web browser or operating system provides to download the file.

### Deleting files or folders in your personal folders

You can delete files or folders in your personal folders on your WebEx service Web site.

**To delete a file or folder:**

1. Open the My Documents page. For details, see *Opening your personal folders, documents, and files* (on page 121).
2. Under **Name**, locate the file or folder that you want to delete.
3. Select the check box for the file or folder that you want delete.
   - You can select multiple files or folders.
4. Click **Delete**.
Chapter 10: Using My WebEx

About the My WebEx Files > My Documents page

How to access this page

On your WebEx service Web site, click My WebEx Files > My Documents.

What you can do here

- Store files that you use in your online sessions or that you want to access when away from your office.
- Specify in which folders that visitors to your Personal Meeting Room can download or upload files.

Options on this page

<table>
<thead>
<tr>
<th>Link or option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Capacity</td>
<td>The storage space available for your files, in megabytes (MB).</td>
</tr>
<tr>
<td>Used</td>
<td>The amount of storage space that your files occupy, in megabytes (MB). Once this value exceeds your capacity, you can no longer store files until you remove existing files from your folders.</td>
</tr>
<tr>
<td>Search for</td>
<td>Lets you locate a file or folder by searching for it. You can search for a file or folder by text that appears in either its name or description. To search for a file or folder, type all or part of its name or description in the box, and then click Search.</td>
</tr>
<tr>
<td>Name</td>
<td>Click this button to refresh the information on the page.</td>
</tr>
<tr>
<td>Path</td>
<td>The folder hierarchy for the folder or file. The Root folder is the top-most folder in which all other folders and files reside.</td>
</tr>
<tr>
<td>Size</td>
<td>The size of the folder or file, in kilobytes (KB).</td>
</tr>
<tr>
<td>Actions</td>
<td>Click the icons to perform an action on the folder or file that is</td>
</tr>
</tbody>
</table>
## Chapter 10: Using My WebEx

<table>
<thead>
<tr>
<th>Link or option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Upload file</td>
<td>Available only for files. Click this icon to open the File Upload page, on which you can select up to three files at a time to upload to a specified folder.</td>
</tr>
<tr>
<td>Download file</td>
<td>Available only for files. Click this icon to download the file associated with it.</td>
</tr>
<tr>
<td>Edit File Properties or Edit Folder Properties</td>
<td>Click this icon to open the Edit File Properties page or Edit Folder Properties page, on which you can edit information about the file or folder, respectively.</td>
</tr>
<tr>
<td>Create Folder</td>
<td>Available for folders only. Click this icon to open the Create Folder page on which you can create a new folder in your personal storage space.</td>
</tr>
</tbody>
</table>

**Shared**

Specifies the sharing settings for a folder; that is, how others who visit your Personal Meetings Room can access your folder and its files.

- **R** Read only: Visitors to your Personal Meeting Room can view the list of files in the folder and download the files.
- **W** Write only: Visitors to your Personal Meeting Room can upload files to the folder, but they cannot view the files in it.
- **R/W** Read and write: Users can view files in the folder, download files from the folder, and upload files to the folder.
- **Password Protected**: Indicates that the folder is password protected. Visitors to your Personal Meeting Room must provide the password you specify to access the folder.

**Select All**

Selects the check boxes for all the folders and files that are visible in the list. You can then click the **Copy** or **Move** button or click the **Delete** link to perform an action on the selected folders or files.

**Clear All**

Clears the check boxes for all the folders and files that are selected in the list.

**Delete**

Deletes the selected folders and files from the list.

**Copy**

Opens a page on which you can copy the selected folder or file to another folder.

**Move**

Opens a page on which you can move the selected folder or file to another folder.
About the Edit Folder Properties page

How to access this page

On your WebEx service Web site, click My WebEx > My Files > Properties icon for folder.

What you can do here

Specify a name, a description, and sharing options for a folder that you created in your personal folders.

Options on this page

<table>
<thead>
<tr>
<th>Use this option…</th>
<th>To…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the name of the folder.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter the description of the folder.</td>
</tr>
<tr>
<td>Share</td>
<td>Specify who can access this folder.</td>
</tr>
<tr>
<td></td>
<td>▪ Do not share this folder: This folder does not appear on your Personal Meeting Room page. Thus, visitors to your page cannot view the folder or access any files in it.</td>
</tr>
<tr>
<td></td>
<td>▪ Share this folder: This folder appears on your Personal Meeting Room. The drop-down list specifies which users can access the folder, as follows:</td>
</tr>
<tr>
<td></td>
<td>□ With all: All visitors to your Personal Meeting Room can access this folder.</td>
</tr>
<tr>
<td></td>
<td>□ With users with host or attendee accounts: Only visitors to your Personal Meeting Room who have either a host account or an attendee account on your WebEx service Web site can access this folder.</td>
</tr>
<tr>
<td></td>
<td>□ With users with host accounts only: Only visitors to your Personal Meeting Room who have a host account on your WebEx service Web site can access this folder.</td>
</tr>
<tr>
<td>Share as</td>
<td>Enter the name for the folder that will appear on your Personal Meeting Room page.</td>
</tr>
<tr>
<td>Read</td>
<td>Let visitors to your Personal Meeting Room view the list of files in the</td>
</tr>
</tbody>
</table>
Chapter 10: Using My WebEx

<table>
<thead>
<tr>
<th>Use this option…</th>
<th>To…</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>folder and download the files.</td>
</tr>
<tr>
<td>Write</td>
<td>Let visitors to your Personal Meeting Room upload files to the folder but does not allow them to view the files in it.</td>
</tr>
<tr>
<td>Read &amp; write</td>
<td>Let users view files in the folder, download files from the folder, and upload files to the folder.</td>
</tr>
<tr>
<td>Allow files to be overwritten</td>
<td>Let users upload a file with the same name as an existing file in the folder and replace the existing file. If this option is not selected, users cannot overwrite any files in the folder.</td>
</tr>
<tr>
<td>Password protected</td>
<td>Let only visitors to your Personal Meeting Room who know the password view the list of files in the folder, download files from the folder, or upload files to the folder, depending on the read/write settings for the folder.</td>
</tr>
<tr>
<td></td>
<td><strong>Password:</strong> The password that visitors to your Personal Meeting Room must provide to access the folder.</td>
</tr>
<tr>
<td></td>
<td><strong>Confirm:</strong> If you specified a password, type it again to verify that you typed it correctly.</td>
</tr>
<tr>
<td>Update</td>
<td>Save any changes that you made to folder's properties, and then closes the Edit Folder Properties window.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Close the Edit Folder Properties window, without saving any of the changes that you made.</td>
</tr>
</tbody>
</table>

**Opening the My Recordings Page**

To upload or maintain recordings, you must do so from the My Recordings page on your WebEx service Web site.

**To open the My Recordings page:**

1. Log in to your WebEx service Web site, and then click **My WebEx**.
2. Click **My Files > My Recordings**.

   The My Recordings page appears, showing your recording files.

For details about the My Recordings page, see *About the My WebEx Files > My Recordings page* (on page 136).
Chapter 10: Using My WebEx

Uploading a recording file

If you recorded a meeting using the integrated or standalone WebEx Recorder, you can upload the recording file, with a .wrf extension, from your local computer to the My Recordings page.

For instructions on editing a recording, see Editing information about a recording (on page 131).

Note: If you recorded a meeting using the WebEx Network-Based Recorder (NBR), the WebEx server automatically uploads the recording file, with an .arf extension, to the appropriate tab on the My Recordings page once you stop the Recorder. You do not need to upload it yourself.

To upload a recording file:

1. Go to the My Recordings page. For details, see Opening the My Recordings page (on page 130).
2. Click Add Recording.
3. On the Add Recording page, enter information and specify options.
   For details about what you can do with each option on the Add/Edit Recordings page, see About the My WebEx Files > My Recordings page (on page 136).
4. Click Save.

Editing information about a recording

You can edit information about a recording at any time.

To edit information about a recording:

1. Go to the My Recordings page. For details, see Opening the My Recordings page (on page 130).
2. Click the following icon for the recording that you want to edit.

The Edit Recording page appears.
3. Make your changes.
For details about what you can do with each option on the Edit Recording page, see About the My WebEx Files > My Recordings page (on page 136).

4 Click Save.

About the Add/Edit Recording page

How to access this page

If you are adding a recording...
1 On your WebEx service Web site, click My WebEx > My Files > My Recordings.
2 Click Add Recording.

If you are editing information about a recording...
1 On your WebEx service Web site, click My WebEx > My Files > My Recordings.
2 Click the More button in the row of the recording that you want to edit.

3 Click Modify.

What you can do here

- Edit general information about a recording, including the topic and description.
- Require a password to play or download the recording.
Options on this page

<table>
<thead>
<tr>
<th>Use this option</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Topic</td>
<td>Specify the topic of the recording.</td>
</tr>
<tr>
<td>Description</td>
<td>Provide a description of this recording.</td>
</tr>
<tr>
<td>Recording file</td>
<td>Click Browse to select the recording file that resides on your local computer.</td>
</tr>
<tr>
<td>Duration</td>
<td>Specify the duration of the recording.</td>
</tr>
<tr>
<td>File size</td>
<td>Displays the size of the recording file. (Available only when editing recording information.)</td>
</tr>
<tr>
<td>Set password</td>
<td>Set an optional password that users must provide to view the recording.</td>
</tr>
<tr>
<td>Confirm password</td>
<td>Confirm the password that users must provide to view the recording.</td>
</tr>
</tbody>
</table>

Playback control options

<table>
<thead>
<tr>
<th>Use this option</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Panel Display Options</td>
<td>Determines which panels are displayed in the recording when it is played back. You can select any of the following panels to be included the recording playback:</td>
</tr>
<tr>
<td></td>
<td>• Chat</td>
</tr>
<tr>
<td></td>
<td>• Q &amp; A</td>
</tr>
<tr>
<td></td>
<td>• Video</td>
</tr>
<tr>
<td></td>
<td>• Polling</td>
</tr>
<tr>
<td></td>
<td>• Notes</td>
</tr>
<tr>
<td></td>
<td>• File Transfer</td>
</tr>
<tr>
<td></td>
<td>• Participants</td>
</tr>
<tr>
<td></td>
<td>• Table of Contents</td>
</tr>
<tr>
<td></td>
<td>Panel display options do not modify the panel display in the actual recording that is stored on the WebEx network.</td>
</tr>
</tbody>
</table>
### Use this option.... To....

<table>
<thead>
<tr>
<th>Recording Playback Range</th>
<th>Determines how much of the recording is actually played back. You can select either of the following:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>▪ <strong>Full playback:</strong> Plays back the full length of the recording. This option is selected by default.</td>
</tr>
<tr>
<td></td>
<td>▪ <strong>Partial playback:</strong> Plays back only part of the recording based on your settings for the following options:</td>
</tr>
<tr>
<td></td>
<td>□ <strong>Start: X min X sec of the recording:</strong> Specifies the time to start playback; for example, you can use this option if you would like to omit the &quot;dead time&quot; at the beginning of the recording, or if you would like to show only a portion of the recording.</td>
</tr>
<tr>
<td></td>
<td>□ <strong>End: X min X sec of the recording:</strong> Specifies the time to end playback; for example, you can use this option if you would like to omit the &quot;dead time&quot; at the end of the recording. You can not specify an end time greater than the length of the actual recording.</td>
</tr>
<tr>
<td></td>
<td>The partial playback range you specify does not modify the actual recording that is stored on the server.</td>
</tr>
<tr>
<td>Include NBR player controls</td>
<td>Includes full Network Recording Player controls, such as stop, pause, resume, fast forward, and rewind. This option is selected by default. If you would like to prevent viewers from skipping portions of the recording, you can turn off this option to omit Network Recording Player controls from the playback.</td>
</tr>
</tbody>
</table>

### About the Recording Information page

**How to access this page**

On your WebEx service Web site, click **My WebEx > My Files > My Recordings > [recording type] > [topic of a recording]**.

**What you can do here**

- View information about the recording.
- Play back the recording.
Chapter 10: Using My WebEx

- Send an email to share the recording with others.
- Download the recording.
- Enable or disable the recording
- Open the Edit Recording page on which you can edit information about a recording.

Options on this page

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Topic</td>
<td>The name of the recording. You can edit the topic at any time.</td>
</tr>
<tr>
<td>Create time</td>
<td>The time and date the recording was created.</td>
</tr>
<tr>
<td>Duration</td>
<td>The length of the recording.</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the recording.</td>
</tr>
<tr>
<td>File size</td>
<td>The file size of the recording.</td>
</tr>
<tr>
<td>Create time</td>
<td>The date and time at which the recording was created.</td>
</tr>
<tr>
<td>Status</td>
<td>The status of the recording. The possible options are Enable or Disable.</td>
</tr>
<tr>
<td>Password</td>
<td>Indicates whether a user must provide a password to view the recording.</td>
</tr>
<tr>
<td>Stream recording link</td>
<td>Clicking the link lets you play the recording (available only for recording files with the .arf extension that were recorded by NBR).</td>
</tr>
<tr>
<td>Download recording link</td>
<td>Clicking the link lets you download the recording.</td>
</tr>
</tbody>
</table>

Play Now

Clicking the button lets you play the recording (available only for recording files with the .arf extension that were recorded by NBR).

If you want to download the recording, you can also click the link for downloading under Play Recorded a meeting Now.

Send Email

Clicking the button opens the Share My Recording window, which allows you to send an email message to selected recipients, inviting them to play your recording.

If you want to send the email with your local email client instead, click the link for using the email client under Share My Recording.
### About the My WebEx Files > My Recordings page

**How to access this page**

Log in to your WebEx service Web site, and then click **My WebEx**. From the left navigation bar, click **My Files > My Recordings**.

**What you can do here**

Manage, upload, and maintain your recording files.

**Options on this page**

View different categories of recordings:

- Meetings
- Events
- Sales Meetings
- Training Sessions
- Miscellaneous

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Modify</strong></td>
<td>Clicking the button opens the Edit Recording page.</td>
</tr>
<tr>
<td><strong>Delete</strong></td>
<td>Clicking the button deletes the recording.</td>
</tr>
<tr>
<td><strong>Disable</strong></td>
<td>Clicking the button disables the recording everywhere it is published on your WebEx Service Web site. (Available only for enabled recordings.)</td>
</tr>
<tr>
<td><strong>Enable</strong></td>
<td>Clicking the button enables the recording everywhere it is published on your WebEx Service Web site. (Available only for disabled recordings.)</td>
</tr>
<tr>
<td><strong>Back to List</strong></td>
<td>Clicking the button returns you to the recording list.</td>
</tr>
</tbody>
</table>
About the My WebEx Files > My Recordings > Meetings page

How to access this page
Log in to your WebEx service Web site, and then click My WebEx. From the left navigation bar, click My Files > My Recordings > Meetings.

About the My WebEx Files > My Recordings > Sales Meetings

How to access this page
Log in to your WebEx service Web site, and then click My WebEx. From the left navigation bar, click My Files > My Recordings > Sales Meetings.

About the My WebEx Files > My Recordings > Miscellaneous page

How to access this page
Log in to your WebEx service Web site, and then click My WebEx. From the left navigation bar, click My Files > My Recordings > Miscellaneous.

Maintaining contact information

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of your personal address book</td>
<td>About maintaining contact information (on page 138)</td>
</tr>
<tr>
<td>open your personal address book</td>
<td>Opening your address book (on page 138)</td>
</tr>
<tr>
<td>add a new contact to your personal address book</td>
<td>Adding a contact to your address book (on page 139)</td>
</tr>
<tr>
<td>add multiple contacts to your address book at once</td>
<td>Importing contact information in a file to your address book (on page 142)</td>
</tr>
<tr>
<td>add contacts in Microsoft Outlook to your personal address book</td>
<td>Importing contact information from Outlook to your address book (on page 145)</td>
</tr>
</tbody>
</table>
### About maintaining contact information

You can maintain a personal online address book, in which you can add information about contacts and create distribution lists. When scheduling a meeting or starting an instant meeting, you can quickly invite any contacts or distribution lists in your personal address book. You can also invite contacts in the Company Address Book for your WebEx service Web site, if one is available.

You can add contacts to your personal address book in any of the following ways:

- Specify information about contacts one at a time.
- Import contact information from your Microsoft Outlook contacts.
- Import contact information from a comma-separated/comma-delimited values (CSV) file.

You can also edit or delete the information about any contact or distribution list in your personal address book.

### Opening your address book

You can open your personal address book on your WebEx service Web site, to view or maintain information about your contacts.

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>See…</th>
</tr>
</thead>
<tbody>
<tr>
<td>view or change information about contacts in your personal address book</td>
<td>Viewing and editing contact information in your address book (on page 146)</td>
</tr>
<tr>
<td>find a contact in your personal address book</td>
<td>Finding a contact in your personal address book (on page 147)</td>
</tr>
<tr>
<td>combine multiple contacts into a single distribution list</td>
<td>Creating a distribution list in your address book (on page 147)</td>
</tr>
<tr>
<td>edit information about a distribution list</td>
<td>Editing a distribution list in your address book (on page 149)</td>
</tr>
<tr>
<td>delete a contact or distribution list</td>
<td>Deleting contact information in your address book (on page 151)</td>
</tr>
</tbody>
</table>
To open your address book:

1. Log in to your WebEx service Web site. For details, see Logging in to and out of the WebEx service site (on page 106).
2. On the navigation bar at the top of the page, click My WebEx.
3. Click My Contacts.
   
The My WebEx Contacts page appears.

The My WebEx Contacts page appears.

4. In the View drop-down list, select one of the following contact lists:
   
   - **Personal Contacts**: Includes any individual contacts or distribution lists that you added to your personal address book. If you have a Microsoft Outlook address book or contacts folder, you can import its contacts to this list of contacts.
   
   - **Company Address Book**: Your organization's address book, which includes any contacts that your site administrator has added to it. If your organization uses a Microsoft Exchange Global Address List, your site administrator can import its contacts to this address book.

**Adding a contact to your address book**

You can add contacts to your personal address book, one at a time.
To add a contact to your personal address book:

1. Open your personal address book. For details, see *Opening your address book* (on page 138).

2. In the View drop-down list, select **Personal Contacts**.
   A list of contacts in your Personal Contacts list appears.

3. Click **Add Contact**.
   The Add Contact page appears.

   **My WebEx Contacts**

<table>
<thead>
<tr>
<th>New Contact</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full name:</td>
</tr>
<tr>
<td>Email address:</td>
</tr>
<tr>
<td>Company:</td>
</tr>
<tr>
<td>Job title:</td>
</tr>
<tr>
<td>URL: (if known)</td>
</tr>
<tr>
<td>Phone number:</td>
</tr>
<tr>
<td>Phone number for mobile device:</td>
</tr>
<tr>
<td>Fax number:</td>
</tr>
<tr>
<td>Address1:</td>
</tr>
<tr>
<td>Address2:</td>
</tr>
<tr>
<td>City:</td>
</tr>
<tr>
<td>State/Province:</td>
</tr>
<tr>
<td>ZIP/Postal code:</td>
</tr>
<tr>
<td>Country/Region:</td>
</tr>
<tr>
<td>User name: (if known)</td>
</tr>
<tr>
<td>Notes:</td>
</tr>
</tbody>
</table>

4. Provide information about the contact.

5. Click **Add**.
For descriptions of the information and options on the New Contact page, see About the New/Edit Contact page (on page 141).

**Note:**
- You cannot add contacts to your Company Address Book.
- If you want to add multiple contacts, you can them all at once, instead of adding one contact at a time. For details, see Importing contact information in a file to your address book (on page 142).

### About the New/Edit Contact page

**How to access this page**

On your WebEx service Web site, click My WebEx > My Contacts > Add Contact or [check box for contact] > Edit.

**What you can do here**

Enter information about a new or existing contact for your personal address book.

**Options on this page**

<table>
<thead>
<tr>
<th>Use this option…</th>
<th>To…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full name</td>
<td>Enter the contact's first and last name.</td>
</tr>
<tr>
<td>Email address</td>
<td>Enter the contact's email address.</td>
</tr>
<tr>
<td>Language</td>
<td>Set the language in which any email messages that you send to the contact using your WebEx service site appear. Available only if your WebEx service Web site can be displayed in two or more languages.</td>
</tr>
<tr>
<td>Company</td>
<td>Enter the company or organization for which the contact works.</td>
</tr>
<tr>
<td>Job title</td>
<td>Enter the contact's position in a company or organization.</td>
</tr>
<tr>
<td>URL</td>
<td>Enter the URL, or Web address, for the contact's company or organization.</td>
</tr>
<tr>
<td>Phone number/Phone number for mobile device/Fax number</td>
<td>Enter the contact's phone numbers. For each number, you can specify the following:</td>
</tr>
</tbody>
</table>
### Use this option… | To...
---|---
Country Code | Specify the number that you must dial if the contact resides in another country. To select a different country code, click the link to display the Country Code window. From the drop-down list, select the country in which the contact resides.
Area or city code | Enter the area or city code for the contact's phone number.
Number | Enter the phone number.
Extension | Enter the extension for the phone number, if any.
Address 1 | Enter the contact's street address.
Address 2 | Enter additional address information, if necessary.
State/Province | Enter the contact's state or province.
ZIP/Postal code | Enter the contact's ZIP or postal code.
Country | Enter the country in which the contact resides.
Username | Enter the username with which the user logs in to your WebEx service Web site, if the contact has a user account.
Notes | Enter any additional information about the contact.

### Importing contact information in a file to your address book

You can add information about multiple contacts simultaneously to your personal address book, by importing a comma-separated values (CSV) file. A CSV file has the `.csv` file extension; you can export information from many spreadsheet and email programs in CSV format.

To create a CSV file:

1. Open your address book. For details, see *Opening your address book* (on page 138).
2. In the **View** drop-down list, ensure that **Personal Address Book** is selected.
3. Click **Export**.
4. Save the `.csv` file to your computer.
5. Open the `.csv` file that you saved in a spreadsheet program, such as Microsoft Excel.
Optional. If contact information exists in the file, you can delete it.

Specify information about the new contacts in the .csv file.

**Important:** If you add a new contact, ensure that the UID field is blank. For information about the fields in the .csv file, see *About the Contact Information CSV template* (on page 143).

Save the .csv file. Ensure that you save it as a .csv file.

To import a CSV file containing new contact information:

1. Open your address book. For details, see *Opening your address book* (on page 138).
2. In the **View** drop-down list, ensure that **Personal Contacts** is selected.
3. In the **Import From** drop-down list, select **Comma Delimited Files**.
4. Click **Import**.
5. Select the .csv file in which you added new contact information.
6. Click **Open**.
7. Click **Upload File**.
   
   The View Personal Contacts page appears, allowing you to review the contact information you are importing.
8. Click **Submit**.
   
   A confirmation message appears.
9. Click **Yes**.

**Note:** If an error exists in any new or updated contact information, a message appears, informing you that no contact information was imported.

---

**About the Contact Information CSV template**

**How to access this template**

On your WebEx service Web site, click **My WebEx > My Contacts > View > Personal Address Book > Export**.
What you can do here

Specify information about multiple contacts, which you can then import to your personal address book.

Fields in this template

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>UUID</td>
<td>A number that your WebEx service site creates to identify the contact. If you add a new contact to the CSV file, you must leave this field blank.</td>
</tr>
<tr>
<td>Name</td>
<td>Required. The contact's first and last name.</td>
</tr>
<tr>
<td>Email</td>
<td>Required. The contact's email address. The email address must be in the following format: <a href="mailto:name@company.com">name@company.com</a></td>
</tr>
<tr>
<td>Company</td>
<td>The company or organization for which the contact works.</td>
</tr>
<tr>
<td>JobTitle</td>
<td>The contact's position in a company or organization.</td>
</tr>
<tr>
<td>URL</td>
<td>The URL, or Web address, for the contact's company or organization.</td>
</tr>
<tr>
<td>OffCntry</td>
<td>The country code for the contact's office phone-that is, the number that you must dial if the contact resides in another country.</td>
</tr>
<tr>
<td>OffArea</td>
<td>The area or city code for the contact's office phone number.</td>
</tr>
<tr>
<td>OffLoc</td>
<td>The contact's office phone number.</td>
</tr>
<tr>
<td>OffExt</td>
<td>The extension for the contact's office phone number, if any.</td>
</tr>
<tr>
<td>CellCntry</td>
<td>The country code for the contact's cellular or mobile phone-that is, the number that you must dial if the contact resides in another country.</td>
</tr>
<tr>
<td>CellArea</td>
<td>The area or city code for the contact's cellular or mobile phone number.</td>
</tr>
<tr>
<td>CellLoc</td>
<td>The contact's cellular or mobile phone number.</td>
</tr>
<tr>
<td>CellExt</td>
<td>The extension for the contact's cellular or mobile phone number, if any.</td>
</tr>
<tr>
<td>FaxCntry</td>
<td>The country code for the contact's fax number-that is, the number that you must dial if the contact resides in another country.</td>
</tr>
<tr>
<td>FaxArea</td>
<td>The area or city code for the contact's fax number.</td>
</tr>
<tr>
<td>FaxLoc</td>
<td>The contact's fax number.</td>
</tr>
<tr>
<td>FaxExt</td>
<td>The extension for the contact's fax machine, if any.</td>
</tr>
</tbody>
</table>
Chapter 10: Using My WebEx

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address 1</td>
<td>The contact's street address.</td>
</tr>
<tr>
<td>Address 2</td>
<td>The additional address information, if necessary.</td>
</tr>
<tr>
<td>State/Province</td>
<td>The contact's state or province.</td>
</tr>
<tr>
<td>ZIP/Postal</td>
<td>The contact's ZIP or postal code.</td>
</tr>
<tr>
<td>Country</td>
<td>The country in which the contact resides.</td>
</tr>
<tr>
<td>Username</td>
<td>The user name with which the user logs in to your WebEx service Web site, if the contact has a user account.</td>
</tr>
<tr>
<td>Notes</td>
<td>Any additional information about the contact.</td>
</tr>
</tbody>
</table>

Importing contact information from Outlook to your address book

If you use Microsoft Outlook, you can import the contacts that you maintain in your Microsoft Outlook address book or folder to your personal address book on your WebEx service Web site.

To import contacts from Outlook to your personal address book:

1. Open your address book. For details, see Opening your address book (on page 138).
2. In the View drop-down list, select Personal Contacts.
3. In the Import from drop-down list, select Microsoft Outlook.
4. Click Import.
   The Choose Profile dialog box appears.
5. In the Profile Name drop-down list, select the Outlook user profile that includes the contact information that you want to import.
6. Click OK.

Note:
- When you import contacts in Outlook, your WebEx service Web site retrieves contact information from the Outlook address book or folder in which you have chosen to keep personal addresses. For information about keeping personal addresses in Outlook, refer to Microsoft Outlook Help.
- If your personal address book already includes a contact who is also in your Outlook
contacts list, the contact is not imported. However, if you change the contact's email address in your personal address book, importing the contact from Outlook creates a new contact in your personal address book.

Viewing and editing contact information in your address book

In your personal address book, you can view and edit information about individual contacts in your Personal Contacts list. You can view, but not edit, information about contacts in your Company Address Book.

To view or edit contact information:

1. Open your address book. For details, see Opening your address book (on page 138).
2. In the View drop-down list, select one of the following:
   - Personal Contacts
   - Company Address Book
   A list of contacts appears.
3. Locate the contact whose information you want to view or edit. For details about locating a contact, see Finding a contact in your personal address book (on page 147).
4. Under Name, select the contact whose information you want to view or edit.
5. Do one of the following:
   - If the contact is in your Personal Contacts list, click Edit.
   - If the contact is in your Company Address Book, click View Info.
   Information about the contact appears.
6. Optional. If the contact is in your Personal Contacts list, edit the information that you want to change on the Edit Contact's Information page.
   
   For descriptions of the information and options of the Edit Contact's Information page, see About the New/Edit Contact page (on page 141).
7. Click OK.
Chapter 10: Using My WebEx

Finding a contact in your personal address book

You can quickly locate a contact in your personal address book, using one of several methods.

To search for a contact in your address book:

1. Open your address book. For details, see Opening your address book (on page 138).
2. In the View drop-down list, select a contacts list.
3. Do any of the following:
   - In the Index, click a letter of the alphabet to display a list of contacts whose names begin with that letter. For example, the name Susan Jones appears under S.
   - To search for a contact in the list you are currently viewing, type text that appears in either the contact’s name or email address in the Search for box, and then click Search.
   - If the entire list of contacts does not fit on a single page, view another page by clicking the links for the page numbers.
   - Sort your personal contacts or company address book by name, email address, or phone number by clicking the column headings.

Creating a distribution list in your address book

You can create distribution lists for your personal address book. A distribution list includes two or more contacts for which you provide a common name and appears in your Personal Contacts list. For example, you can create a distribution list named Sales Department, which includes contacts who are members of your Sales Department. If you want to invite members of the department to a meeting, you can select the group rather than each member individually.

To create a distribution list:

1. Open your address book. For details, see Opening your address book (on page 138).
2. Click Add Distribution List.
   - The Add Distribution List page appears.
3 In the **Name** box, type the name of the group.

4 Optional. In the **Description** box, type descriptive information about the group.

5 Under **Members**, locate the contacts that you want to add to the distribution list, by doing any of the following:
   - Search for a contact, by typing all or part of the contact's first or last name in the **Search** box.
   - Click the letter that corresponds to the first letter of the contact's first name.
   - Click **All** to list all contacts in your Personal Contacts list.

6 Optional. To add a new contact to your Personal Contacts list, under **Members**, click **Add Contact**.

7 In the box on the left, select the contacts that you want to add to the distribution list.

8 Click **Add** to move contacts you selected to the box on the right.

9 After you finish adding contacts to the distribution list, click **Add** to create the list.
In your Personal Contacts list, the Distribution List indicator appears to the left of the new distribution list:

For descriptions of the information and options on the Add Distribution List page, see About the Add/Edit Distribution List page (on page 150).

Editing a distribution list in your address book

You can add or remove contacts from any distribution list that you have created for your personal address book. You can also change a group's name or descriptive information.

To edit a distribution list:

1. Open your address book. For details, see Opening your address book (on page 138).

2. In the View drop-down list, select Personal Contacts.

A list of the contacts in your Personal Contacts list appears, including any distribution lists that you have created. The Distribution List indicator appears to the left of a distribution list:

Under Name, select the name of the distribution list. The Edit Distribution List page appears.
Chapter 10: Using My WebEx

3. Edit information about the distribution list.

4. Click Update.

For descriptions of the information and options on the Edit Distribution List page, see About the Add/Edit Distribution List (on page 150).

About the Add/Edit Distribution List page

How to access this page

On your WebEx service Web site, click My WebEx > My Contacts > Add Distribution List. Or, select distribution list in Personal Contacts list.
Chapter 10: Using My WebEx

What you can do here

Add contacts to your distribution list or remove contacts from your distribution list.

Options on this page

<table>
<thead>
<tr>
<th>Use this option...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the name of the distribution list. For example, if you want to add a distribution list that includes members of your company's sales department, you might name the list Sales Department.</td>
</tr>
<tr>
<td>Description</td>
<td>Optionally enter descriptive information about the distribution list, to help you identify it later.</td>
</tr>
<tr>
<td>Search</td>
<td>Find a contact, by typing all or part of the contact's first or last name.</td>
</tr>
<tr>
<td>Index</td>
<td>Find a contact, by clicking the letter that corresponds to the first letter of the contact's first name. To list contacts for which you identified with a number, click #. To list all contacts in your Personal Contacts list, click All.</td>
</tr>
<tr>
<td>Add&gt;</td>
<td>Add a one or more selected contacts to your distribution list.</td>
</tr>
<tr>
<td>&lt;Remove</td>
<td>Remove one or more selected contacts from your distribution list.</td>
</tr>
<tr>
<td>Add Contact</td>
<td>Add a new contact to your Personal Contacts list and add the contact to your distribution list.</td>
</tr>
<tr>
<td>Add</td>
<td>Add a new distribution list to your Personal Contacts list.</td>
</tr>
<tr>
<td>Update</td>
<td>Update an existing distribution list that you have edited.</td>
</tr>
</tbody>
</table>

Deleting contact information in your address book

You can delete any contact or distribution lists that you have added to your personal address book.

To delete a contact or contact group:

1. Open your address book. For details, see Opening your address book (on page 138).
2 In the View drop-down list, select **Personal Contacts**.

3 In the list that appears, select the check box for the contact or distribution list that you want to delete.

4 Click **Delete**.

   A message appears, asking you to confirm the deletion.

5 Click **OK**.

### Maintaining your user profile

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>See…</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of maintaining your user profile</td>
<td>About maintaining your user profile (on page 152)</td>
</tr>
<tr>
<td>edit your user profile</td>
<td>Editing your user profile (on page 158)</td>
</tr>
</tbody>
</table>

#### About maintaining your user profile

Once you obtain a user account, you can edit your user profile at any time to do the following:

- Maintain personal information, including your
  - Full name
  - Username (if your site administrator provides this option)
  - Password
  - Contact information (including your street address, email address, and phone numbers)
  - Tracking codes that your organization uses to keep records of your meetings (such as project, department, and division numbers)
- Specify whether to display links to your company's partner sites in the My WebEx navigation bar, if your site administrator set up partner links
- Manage any scheduling templates that you saved
- Set options for your Personal Meeting Room options, including the images and welcome message that appear on the page
- Set default options for your online sessions, including
  - The default session type that you want to use, if your account includes multiple session types
- Set Web site preferences, including:
  - The home page that appears when you access your WebEx service Web site
  - The time zone in which meeting times appear
  - The language in which your Web site displays text, if your site includes multiple languages
  - The locale (the format in which your Web site displays dates, times, currency values, and numbers)

About the My WebEx Profile page

How to access this template

On your WebEx service Web site, click My WebEx > My Profile.

What you can do here

Manage the following:
- Account information
- Personal information
- Partner integration options
- Scheduling templates (does not apply to Support Center)
- Personal Meeting Room information
- Meeting options
- Web page preferences, including your home page and language
- Support Center CSR Dashboard options (Support Center only)
Chapter 10: Using My WebEx

Personal Information options

<table>
<thead>
<tr>
<th>Use this option...</th>
<th>To...</th>
</tr>
</thead>
</table>
| Username           | Specify the username for your account. You can change this name only if the administrator for your WebEx service Web site provides this option.  
**Tip:** If you need to change your username, but cannot edit it on this page, ask your site administrator to change your username or create a new account for you. |
| Change Password    | **Old password:** Type the old password for your account.  
**New password:** Specify the new password for your account. A password:  
☐ Must contain at least four characters  
☐ Can consist of a maximum of 32 characters  
☐ Can include any letters, numbers, or special characters, but not spaces  
☐ Is case sensitive  
**Retype New password:** Verify that you typed your password correctly in the **New password** box. |
| Call-in authentication | If enabled by your site administrator, allows you to be authenticated and placed into the correct teleconference without needing to enter a meeting number whenever you dial into any CLI (caller line identification) or ANI (automatic number identification) enabled teleconference. Selecting this option for a phone number in your user profile maps your email address to that phone number. Caller authentication is available only if you have been invited to a CLI/ANI enabled teleconference by email during the meeting scheduling process. Caller authentication is not available if you are dialing in to a CLI/ANI enabled teleconference. |
| Call-back          | When selected for a phone number in your user profile, allows you to receive a call from the teleconferencing service if it is using an integrated call-back feature. If your site includes the international call-back option, participants in other countries receive a call back. For more information about this option, ask your site administrator. |
| PIN                | If enabled by your site administrator, allows you to specify a call-in authentication PIN to prevent “spoofers” from using your number to dial into a teleconference. If your site administrator sets the authentication PIN as mandatory for all accounts using call-in authentication on your site, you must specify a PIN number or caller authentication will be disabled for your account. This option is available only if you have selected the **Call-in authentication option** for at least one of the phone
Use this option... To...

numbers in your profile. The PIN can also be used to provide a secondary level of authentication for calls where the host is using the phone and may need to invite additional attendees.

Other personal information options

Enter any personal information that you want to maintain in your profile.

Partner integration options

Your site administrator can set up custom links to the Web sites of your company's partners, and then display the links on the My WebEx navigation bar. For example, if your company uses another company's Web site to provide a service, your site administrator can provide a link to that company's site in your My WebEx navigation bar. You can then show or hide that link.

Use this option... To....

Display partner links in My WebEx Shows or hides partner site links in the My WebEx navigation bar.

Personal Meeting Room options

Use this option... To...

Personal Meeting Room URL Go to your Personal Meeting Room page. You can click the URL from the My Profile page to preview your current Personal Meeting Room page.

Your Personal Meeting Room page shows online sessions that you scheduled and any in-progress sessions that you are currently hosting.

Users to whom you provide your personal URL can use this page to join any meeting that you are hosting. They can also download files in any folders that you share.

Welcome Message Enter the message that appears on your Personal Meeting Room page. A message can be a maximum of 128 characters, including spaces and punctuation.

To specify a message, type it in the box, and then click Update.
**Chapter 10: Using My WebEx**

<table>
<thead>
<tr>
<th>Use this option...</th>
<th>To...</th>
</tr>
</thead>
</table>
| **Upload Image**                   | Upload an image file from your computer or another computer on your network to your Personal Meeting Room page. For example, you can upload a picture of yourself, your company’s logo, or a picture of your company’s product. Visitors to your page can see the image that you upload.  

The image can be an maximum of 160 pixels wide. If you upload a larger image, its width is automatically reduced to 160 pixels. However, the image’s aspect ratio is maintained.  

**Browse**: Lets you locate an image.  

**Upload**: Uploads the image that you selected.  

**Current Image**: Displays the image that currently appears on your Personal Meeting Room page.  

**Delete**: Removes the current image from your Personal Meeting Room page. This button is available only if you have uploaded an image for the page. |
| **Customize branding of header area** | Upload a banner image to the non-scrolling header area for your Personal Meeting Room page. For example, you can upload your company’s logo or an advertisement. Visitors to your page can see the image that you upload. Available only if your site administrator has turned on this option for your account.  

The image can be an maximum of 75 pixels high. If you upload a larger image, its height is automatically reduced to 75 pixels. However, the image’s aspect ratio is maintained.  

**Browse**: Lets you locate a banner image.  

**Upload**: Uploads the banner image that you selected.  

**Current Image**: Displays the banner image that currently appears on your Personal Meeting Room page.  

**Delete**: Removes the current banner image from your Personal Meeting Room page. This button is available only if you have uploaded an image for the page. |
| **Productivity Tools Options**     |                                                                                                                                                                                                                                                                 |
| **Use this option...**              | **To...**                                                                                                                                                                                                 |
| **Automatically download Productivity Tools when logging in to the WebEx service site** | Specify that WebEx Productivity Tools should be downloaded automatically when you log in to the WebEx service site. If this option is turned off, you can still download Productivity Tools manually. |
### Session Options

<table>
<thead>
<tr>
<th>Use this option...</th>
<th>To...</th>
</tr>
</thead>
</table>
| **Default session type** | Specify the default session type that you host, if your user account lets you host different types of online sessions.  
For more information about session types, ask the site administrator for your WebEx service.  
You can change this default setting when scheduling a meeting. |

### Web page preferences options

<table>
<thead>
<tr>
<th>Use this option...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Home page</strong></td>
<td>Set the first page that appears when you access your WebEx service Web site.</td>
</tr>
</tbody>
</table>
| **Time zone** | Set the time zone in which you reside.  
If you select a time zone for which daylight saving time (DST) is in effect, your WebEx service Web site automatically adjusts its clock for daylight saving time  
**Note:** The selected time zone appears:  
- Only on your view of your WebEx service Web site, not other users’ views  
- In all meeting invitations that you send using your WebEx service Web site |
| **Language** | Set the language in which your WebEx service Web site displays text.  
**Note:** The languages that appear in this list are limited to the languages that have been set up for your Web site. |
| **Locale** | Set the format in which your Web site displays dates, times, currency values, and numbers. |
Support Center options

<table>
<thead>
<tr>
<th>Use this option...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Order of tabs</td>
<td>Specify the order in which the tabs appear on the CSR dashboard. To change the order of tabs, select a tab in the box, and then click the Move Up or Move Down button to move the tab's position. The topmost tab in the list appears as the first tab on the CSR dashboard.</td>
</tr>
</tbody>
</table>

Editing your user profile

Once you obtain a user account, you can edit your user profile at any time to change account login information, contact information, and other options available for your account.

To edit your user profile:

1. Log in to your WebEx service Web site. For details, see Logging in to and out of the WebEx service site (on page 106).
2. On the navigation bar, click My WebEx.
3. Click My Profile.
4. Edit the information on the page.
5. When you are finished editing your user profile, click Update.

For descriptions of the information and options on the My Profile page, see About the My WebEx Profile page (on page 153).

Generating Reports

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of what reports you can generate from your WebEx service Web site</td>
<td>About generating reports (on page 159)</td>
</tr>
</tbody>
</table>
## If you want to...

<table>
<thead>
<tr>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>generate usage reports that provide information about each session that you have hosted on your site</td>
</tr>
<tr>
<td>run a query to display information about certain sessions</td>
</tr>
</tbody>
</table>

### About generating reports

If your user account includes the reports option, you can view the following reports:

**Note:**
- For some reports, if you click on the report link within 15 minutes after the meeting ends, you will see a preliminary version of that report. The preliminary report provides quick access to data before the final, more accurate data is available. The preliminary report contains only a subset of the information that is available in the final report.
- When the final, more accurate data is available, which is usually 24 hours after the meeting ends, the preliminary report is replaced by the final report.
- You can download both preliminary reports and final reports as comma-separated values (CSV) files.

### General Meeting Usage reports

These reports contains information about each online session that you host. You can view the following reports:

- **Summary Usage report:** Contains summary information about each meeting including topic, date, start and end time, duration, number of attendees you invited, number of invited attendees who attended, and type of voice conference you used.

  **Note:** Initially, this report appears as a Preliminary Usage Summary Report, but after the final, more accurate usage data is available, it is replaced by the Final Usage Summary Report.

- **Summary Usage report CSV (comma-separated values) file:** Contains additional details about each meeting, including the minutes that all participants were connected to the meeting and tracking codes.
Chapter 10: Using My WebEx

- **Session Detail report:** Contains detailed information about each participant in a meeting, including the time the participant joined and left the meeting, the attentiveness during the meeting, and any information that the attendee provided.

  **Note:** Initially, this report appears as a Preliminary Session Detail Report, but after the final, more accurate session detail data is available, it is replaced by the Final Session Detail Report.

**Access Anywhere usage report**

This report shows information about the computers that you access remotely, including the date and start and end times for each session.

**Support Center reports**

This report contains support session information including session number, start and end times, tracking codes, and any information that the customer provided on the Pre- and Post-Session forms. If you are a manager, you can also generate reports for all users and sessions which are assigned to you.

- **Session Query tool:** You can enter search criteria and display a list of sessions that meet the search criteria you specify. The query returns the CSR name, customer name and email address, session ID, request time, date, and start and end times.

- **Call Volume report:** Shows the number of successful and abandoned requests and the minimum, average, and maximum wait and session times.

- **CSR Activity report:** Shows the number of sessions and the minimum, maximum, and average session time for each CSR.

- **URL Referral report:** Shows the URLs, the number of site visitors, and the number attempted and successful support sessions.
Maintaining your Cisco Unified MeetingPlace Audio Conferencing accounts

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>See…</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of maintaining Cisco Unified MeetingPlace audio conferencing account numbers</td>
<td>About maintaining Cisco Unified MeetingPlace audio conferencing account numbers (on page 161)</td>
</tr>
<tr>
<td>reset the password for your Cisco Unified MeetingPlace audio conferencing account</td>
<td>Resetting the password for your Cisco Unified MeetingPlace audio conferencing account number (on page 161)</td>
</tr>
</tbody>
</table>

About maintaining Cisco Unified MeetingPlace audio conferencing account numbers

If your site includes support for Cisco Unified MeetingPlace audio conferencing, you should already have a Cisco Unified MeetingPlace audio conferencing account assigned to you. With your account, you can use Cisco Unified MeetingPlace audio in your meetings and in MeetingPlace Personal Conference meetings.

Your account number includes a toll number to call as well as a Cisco Unified MeetingPlace profile number. For additional security, you can specify or reset a profile PIN that can be used to authenticate your account. You can also synchronize your account settings for your WebEx and Cisco Unified MeetingPlace accounts.

Resetting the profile PIN for your Cisco Unified MeetingPlace audio conferencing account number

If your site includes support for Cisco Unified MeetingPlace audio conferencing, you should already have a Cisco Unified MeetingPlace audio conferencing account assigned to you. You can change the personal identification number (PIN) for your Cisco Unified MeetingPlace audio conferencing account.

To add or edit a Personal Conference number account:

1. Log in to your WebEx service Web website, and then select My WebEx.
2. Select Personal Conferencing.
The Personal Conferencing page appears.

3 Under **Change Profile PIN**, in the **New profile PIN** and **Confirm profile PIN** boxes, type a new personal password that contains only numbers and is between 5 and 24 digits in length.

4 To synchronize your account settings for your WebEx and Cisco Unified MeetingPlace accounts, select **Sync**.

**About the Personal Conferencing page**

**How to access this page**

On your WebEx service Web site, click **My WebEx > Personal Conferencing**.

**What you can do here**

- Add, edit, or delete a Personal Conference number account.
- View information about your existing Personal Conference number accounts.
- If you are a MeetingPlace user, view information about your Cisco Unified MeetingPlace Audio Conferencing account and change your profile PIN.
## Options on this page for Personal Conference number accounts only

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Personal Conference number</strong></td>
<td>Shows the numbers for your Personal Conference number accounts. With a Personal Conference number account, you can use the same conference numbers for all your meetings, including Personal Conference meetings that you schedule on your WebEx service Web site or that you start instantly from a phone. A Personal Conference number account also lets you specify the access codes that you want to use to start the audio portion of the Personal Conference meeting, and the access codes that you want attendees to use to join the audio portion. For details about the information in a Personal Conference number account, see About the Add/Edit Personal Conference Number page.</td>
</tr>
<tr>
<td><strong>Account [x]</strong></td>
<td>Allows you to add a new Personal Conference number accounts or view and edit information about each of your Personal Conference number accounts.</td>
</tr>
<tr>
<td></td>
<td><strong>Add account:</strong> Opens the Create Personal Conference Number page, on which you can obtain a Personal Conference number (PCN) account. Appears only if you have not yet added the maximum of three accounts.</td>
</tr>
<tr>
<td></td>
<td><strong>Default account:</strong> Indicates that the PCN account is the default account that is selected when you schedule a Personal Conference meeting.</td>
</tr>
<tr>
<td></td>
<td><strong>Set as default:</strong> If you set up more than one PCN account, you can click this link to specify which account is your default account.</td>
</tr>
<tr>
<td><strong>Edit</strong></td>
<td>Opens the Edit Personal Conference Number page, on which you can change the access codes for your PCN account.</td>
</tr>
<tr>
<td></td>
<td>For details about the information in a PCN account, see About the Create/Edit Personal Conference Number.</td>
</tr>
<tr>
<td><strong>Delete</strong></td>
<td>Deletes the Personal Conference number (PCN) account from your user profile.</td>
</tr>
<tr>
<td></td>
<td><strong>Important:</strong> If you delete a PCN account that you have already selected for a scheduled meeting, you must edit the meeting to select another PCN account or voice-conferencing option.</td>
</tr>
</tbody>
</table>
Options on this page for MeetingPlace users only

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toll Number</td>
<td>Shows the toll telephone number for your Cisco Unified MeetingPlace audio conferencing account.</td>
</tr>
<tr>
<td>Cisco Unified MeetingPlace profile number</td>
<td>Shows your Cisco Unified MeetingPlace audio conferencing account profile number.</td>
</tr>
<tr>
<td>New profile PIN</td>
<td>Allows you to reset your Cisco Unified MeetingPlace audio conferencing account profile personal identification number (PIN) in order to provide an additional level of security to your audio account.</td>
</tr>
</tbody>
</table>

Generating reports

You can generate usage reports that provide information about each online meeting that you have hosted on your site.

You can export or download the data to a comma-separated values (CSV) file which you can then open in a spreadsheet program such as Microsoft Excel. You can also print reports in a printer-friendly format.

To generate a report:

1. Log in to your WebEx service Web site, and then click **My WebEx**.
2. Click **My Reports**.
   The My Reports page appears.
3. Choose the type of report you want to generate.
4. Specify your search criteria, such as a date range for which you want to view report data.
5. Click **Display Report**.
6. To change the order in which report data is sorted, click the column headings.
   The report data is sorted by the column that has an arrow next to the column heading. To reverse the sort order, click the column heading. To sort using another column, click that column’s heading.
7. Do one of the following, as appropriate:
If you are viewing a general meeting usage report and want to display the report in a format that is suitable for printing, click **Printer-Friendly Format**.

8 If you are viewing the usage report for a meeting and want to view the content in the report, click the link for the meeting name.

9 To export the report data in comma-separated values (CSV) format, click **Export Report** or **Export**.

10 If available, click links on the report to display more details.

### Generating session data: The Query Tool

You can use the Query Tool to generate a report that contains the following support session information:

- Session ID
- Session date, request, wait, start, and end times
- Queue name
- CSR name
- Customer email address

**To query session data:**

1 Log in to your WebEx service Web site, and then click **My WebEx**.

2 Click **My Reports**.
   
   The My Reports page appears.

3 Click **Query Session Tool**.

4 Specify appropriate date range criteria from the drop-down lists.

---

**Note:** Only three months of report data is available.

5 Only three months of report data is available.

6 Select the appropriate queues from the Queues list box or select the **All** check box.

7 Select support representatives from the CSRs list box or select the **All** check box.
8 Optional. Select additional search criteria from the **Search** string drop-down lists.

9 Optional. Indicate how you want the results sorted by selecting an item from the **Sort** results by drop-down list.

10 Click **Display Report**.

A list of support sessions based on your search criteria appears.

To export the report data in comma-delimited values (CSV) format, click **Export to CSV**.

To change the order in which report data is sorted, click the column headings.

The report data is sorted by the column that has an arrow next to the column heading. To reverse the sort order, click the column heading. To sort using another column, click that column’s heading.

To display the report in a format that is suitable for printing, click **Printer-Friendly Format**.
F
features of Support Manager • 3

I
information about customer's computer • 44, 50
printing • 50
saving to file • 50
viewing • 44
inviting • 22, 24
another support representative to support session • 24
customer to support session • 22

J
joining • 38
a voice call • 38
joining support session • 19, 27
helping customer with • 19
to assist another support representative • 27

L
leaving • 41
a voice call • 41
logging on to customer's computer • 50

M
microphone • 39, 40
passing to participant in a voice call • 39
using in a voice call • 40

O
options • 41
for voice call • 41

P
participants • 39
allowing to speak in a voice call • 39
permission from customer, automatic • 31
printing • 50, 73
documents on customer's computer • 73
information about customer's computer • 50

R
recording • 21
starting • 21
Remote Support • 1
overview • 1
restarting customer's computer • 52

S
saving • 50, 80, 85
annotated view of shared desktop or application • 80
chat messages • 85
information about a customer's computer • 50
screen capture, taking of desktop • 80
Session tab, overview • 12
shared application • 31, 66, 67, 69, 71, 74
controlling customer's • 67
controlling view of customer's • 74
giving control to customer • 71
obtaining permission to view or control automatically • 31
showing to customer • 69
viewing customer's • 66
shared desktop • 31, 60, 61, 63, 64, 74
controlling customer’s • 61
controlling view of customer’s • 74
giving control to customer • 64
obtaining permission to view or control automatically • 31
showing to customer • 63
viewing customer’s • 60
start recording • 21
starting a voice call • 36
Support Manager • 1, 3, 17
CSR dashboard, overview • 3
features • 3
overview • 1
setting up • 17
support session • 19, 22, 24, 27, 29, 30, 32
ending • 32
helping customer to join • 19
inviting support representative • 22, 24
providing assistance during • 27
starting • 19
transferring control • 29
transferring to a WebACD agent • 30
system information • 44, 50
printing • 50
saving to file • 50
viewing customer’s • 44
leaving • 41
letting participants speak • 39
microphone, using to speak • 40
overview • 35
rejoining • 41
starting • 36
using the Audio Setup Wizard • 41
Voice call options • 41
Volume • 41
setting in a voice call • 41

W
WebACD agent • 29, 30
transferring a session to • 30
transferring session control to • 29

T
tips for sharing desktops or applications • 75
transferring • 29, 30, 53, 54, 55
control of a support session • 29
files to or from customer’s computer • 53, 54, 55
support session to a WebACD agent • 30

V
Voice Call • 35, 36, 38, 39, 40, 41
adjusting volume • 41
ending • 36
joining • 38